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1. Setting up graphic properties for a course 
The Properties tab, which is available from the Course node, allows you to set color preferences for 
Static/Dynamic Pointers and Area Highlighters.  

 

Figure 1 : Screengrab of Properties Tab in Synergy 

By default, both pointer and highlighter colors are set to yellow.  

Note: Only SkillSoft personnel or the Lead Designer should ever edit these settings. 

Changing the pointer color 
1. Select a color from the available colors in the Static/Dynamic Pointer Color drop-down list. 

Changing the Area Highlighter color 
1. Click the Choose Color button associated with Area Highlighter Color. 

2. Select a color from the swatches available. 

a. Alternatively, specify a color by entering HSB values for a color in the HSB tab, or enter 
RGB values in the RGB tab. 

3. Click OK. 
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Enabling Video in a Course 
In most courses, video is enabled by the person planning or scripting the course. However, when video is 
being added to a course retroactively, you may need to use the Video tabbed page on the course node to 
set the course up to include video.  

To enable video in a course, you complete these steps: 

1. Select the Course node in the Outline pane, and then click the Video tab in the Content pane to 
open the Video tabbed page. 

2. Determine which platform you would like to enable video for, and determine which format of 
video you would like to enable. Select the appropriate video format checkbox for the platform 
you wish to enable. 

3. Click the Apply button. 

4. When a video format has been selected, two spin boxes on the Video tab are enabled. These spin 
boxes allow you to set a default size for the videos in Video Standard Caption pages. The settings 
chosen here can be overridden on the individual pages. The default setting here is the maximum 
video size, 768 x 432.  

 

Note: For information on configuring the settings on the other Course node tabbed 
pages, or for information on completing general tasks in Synergy (i.e. not Graphics-
specific), you should refer to “Section 1: Introduction to Synergy” in the Writing Tab 
Manual. 

 

Enabling Tablet Support in a Course 

To enable Tablet Support in a course, you complete these steps: 

1. Select the Course node in the Outline pane, and then click the Properties tab in the Content pane 
to open the Properties tabbed page. 

2. Click the Tablet Ready checkbox 

3. Not all Synergy templates will play on a Tablet device. If the course contains any unsupported 
templates a dialog box will appear to warn you. You may have to delete the templates, replace 
them with alternatives, or decide not to convert the course to Tablet.  

4. When a course is played on a Tablet device it will require some new versions of the media files. 
See the Tablet Media File Conversion guideline for details of the files that must be supplied and 
how to convert them. The Synergy audit will detect if any of these files are not present in a 
Tablet-enabled course.    
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Integrating Video in a Course 
Video must be integrated at topic level within a course. To integrate video in a topic, you complete these 
steps: 

1. Name the video files as per the filenames indicated in the relevant pages in Synergy 

2. Using Windows Explorer, copy the video files into the media\video folder at topic level in the 
Synergy course structure 

Integrating Audio in a Course 
Audio must be integrated at topic level within a course. To integrate audio in a topic, you complete these 
steps: 

1. Name the audio files as per the filenames indicated in the relevant pages in Synergy 

2. Using Windows Explorer, copy the audio files into the media\audio folder at topic level in the 
Synergy course structure 
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2. Understanding the link between the Writing tab and the Graphics tab 

Using information from the Writing tab 
The Writing tab is where the textual content for each page is entered by the writer. However, it also 
contains important information for the designer: 

• Narrative text 
This is the text that will appear on screen and accompany your design. You should always read 
this text before designing your page, so that you know what your design should illustrate. 

• Graphic Direction 
The writer provides specific directions to the Visual Designer in the Graphic Direction text field. 
This may include suggestions for graphics, graphic requirements for the page, or required Graphic 
Text to be incorporated into the page design.  

• Graphic Text 
The writer may specify graphic text in the Graphic Text field. There are three types of graphic 
text:  

• "plain" graphic text that overlays the graphic background  

• hotspot text, which is graphic text that then becomes clickable on an Explore Graphic page  

• text embedded in visuals such as charts, graphs, etc.  

• Alt text 
Alternative text is text which describes the on-screen graphics for screenreader users. If the 
writer has provided alternative text, you must ensure that your design for the page supports this 
text. 

• Graphic References 
These are references to screengrabs and other graphics, which may form the basis for the page 
design. 

Accessing information from the Writing tab in the Graphics tab 
1. When a page element is selected in the Select tab, the narrative text for that page element is 

displayed in the main graphics pane. 

2. By default, the Graphic Direction window is displayed in the Graphics tab. 

a. If the Graphic Direction window is not displayed, you can view it by selecting View – 
Show Window – Graphic Direction. 

3. To view the Graphic References, Graphic Direction, Alt text, and Graphic Text for each page 
element, select each element in turn from the Page element drop-down list in the Graphic 
Direction window. 
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Assigning Static and Draggable screen layouts 
The Draggable checkbox enables you to determine whether the page is static or draggable.  

 

Figure 2 : The standard static layout 

If the page is static, the text always appears in a set position. For example, in a static Expos page, the text 
is on the left of the screen, with space for graphics on the right.  

 

Figure 3 : The standard draggable layout 

If the page is draggable, the Visual Designer can decide where the starting position for the text box should 
be, and the entire screen area is available for graphics. Draggable layouts are particularly useful for 
screengrab-based content. 
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Figure 4 : Writing Tab with Draggable checkbox selected 

Applying Draggable format to a page  
Complete the following step: 

• Select the Draggable checkbox. 

Note: The designer shouldn't change a static page to draggable without first 
consulting the writer or the Learning Designer. 

Re-applying Static format to a page 
Most pages in Synergy are static by default. However, if a page has been accidentally set to draggable and 
needs to be reverted to static format, you can do this by completing this step: 

• Clear the Draggable checkbox. 

Note: Changing a page to Static triggers an alert box, which warns that making 
this change may cause some graphics to be repositioned and others may no longer 
fit on the page. 

Determining the available Graphics area 
The available graphics area differs, depending on whether the page is set to static or draggable. At any 
point, you can determine what the maximum graphic dimensions are by rolling-over the grid in the 
Graphics area to display a tooltip.   
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Figure 5: Determining the maximum graphic dimensions by rolling-over the grid 

 

Figure 6: Designing a page with the Draggable checkbox cleared 
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Figure 7: Designing a page with the Draggable checkbox selected 

Assigning Standard and Wide text layouts 
The Width drop-down list allows you to specify the width of the text box as Standard or Wide. In general, 
the Wide setting is only applied to a text box when necessary to prevent a text overrun or localization 
overrun error. 

Changing the text box width 
Complete the following step: 

• Select the width you want from the Width drop-down list. Depending on the page type that you 
are working on, available widths may include Narrow, Standard, or Wide. 

 
Figure 8 : The Width drop-down list, with the Standard option selected 
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3. Features of the Graphics tab 
The Graphics tab is the working area for the designer in Synergy. Here, the designer integrates the 
graphics or screengrabs for a page, creates animations, organizes the layout of the page and sets up any 
interactivity on the page. 

 

Figure 9: The Graphics tab 

The Graphic area 
The Graphics area, denoted by a grid in the Graphics tab, is the space where you can add graphics to the 
Synergy page. Depending on the type of page you are working on, this area can form a small section of 
the screen, or it may encompass half or even the full screen area. When you rollover the graphic area, a 
tooltip appears indicating the maximum dimensions of a graphic for that page. 

The Assign To tab 
The Assign To tab is used to associate graphics with a page element, such as a Text item or Hotspot. It 
contains a Trigger Item drop-down list which allows you to choose between all of the elements on the 
page to which you can assign a graphic. It contains six columns including Target, Show, Start, Hide, Show 
Rollover, and Hide Rollover.  

• The Target column  
This lists the graphics, buttons, and animations that are currently assigned, or are available to be 
assigned to the selected page element.  
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• The Show column  
Selecting the Show checkbox associated with an item in the Target column sets that graphic or 
button to show with the page element currently selected in the Trigger Item drop-down list. 

• The Start column 
Selecting the Start checkbox associated with an animation in the Target column, specifies that 
you want to launch a staged animation with the page element currently selected in the Trigger 
Item drop-down list. 

• The Hide Column 
Selecting the Hide checkbox associated with a graphic or button assigns it to hide when the page 
element currently selected in the Trigger Item drop-down list is displayed. 

• Show Rollover 
The Show Rollover checkbox allows you to set a graphic to show when the hotspot selected in the 
Trigger Item drop-down list is rolled over. 

• Hide Rollover 
The Hide Rollover checkbox allows you to set a graphic to hide when the hotspot selected in the 
Trigger Item drop-down list is rolled over. 

The Properties box 
The Properties box indicates the height and width of a graphic as well as its X and Y coordinates in the 
Graphics area. The Properties box area also displays the Alpha value of a graphic, the degree of rotation, 
and the scale of the graphic. You can edit all of the graphic properties except the width and height. These 
are fixed. To change the width or height of a graphic, you must edit the graphic in an external graphics 
application, such as Photoshop, and then add the resized graphic to Synergy. 

 

 

Figure 10: The Properties Box 
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The Effects tab 
The Effects tab allows you to apply animation effects such fading, wiping, flashing, flying in, and flying out 
to selected graphics when they appear onscreen or when they are removed from the screen. By applying 
these effects as “Show Effects”, you ensure that the effect is applied when the graphic is set to Show. 
Alternatively, you can apply effects as “Hide Effects”, which ensures that the effect is applied when the 
graphic is set to Hide. 

 

 

Figure 11: The Effects Tab 
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The Image Memory tab 
The Image Memory tab helps you to adhere to the SkillSoft standards regarding image size, by providing 
you with easy access to information on image size, including size on disk, memory usage, and size in 
memory. 

You should always check the Image memory tab once the graphics have been added to the page and 
ensure that the ‘Size on Disk’ value is not over 100k, or 200k, depending on the page type, and that the 
‘Size in Memory’ value does not exceed 12288kb 

Note: The limit on HTML Caption, Try It and SkillCheck pages is 200k from Synergy 
1.19 onwards. The limit for all other page types remains at 100k. 

Information on image size standards is available in the Graphic File Size Optimization guideline. 

 

Figure 12: The Image Memory tab 

 

Graphics Tab Manual Visual_Design_Graphics_Tab_Manual 
Last saved by: Ray Cunningham Date: 07 August 2014 Page 17 of 177 

 



The Graphic Direction window 
The Graphic Direction window allows you to quickly access the Graphic Direction stored within the 
Writing tab while you are working in the Graphics tab. It contains a Page Elements drop-down list where 
you can specify which page element you want to view the Graphic Direction for. For example, selecting 
Text Item 2 from the page elements drop-down list will display any graphics references, graphic direction, 
or alt text that the writer has provided for the second Text Item on the page. 

You must be working within the Graphics tab to access the Graphic Direction Window 

 

Figure 13: The Graphic Direction Window 

Accessing the Graphic Direction window 
1. Select View - Show Window - Graphic Direction. 
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The Timeline window 
The Timeline window enables you view the timeline for animations within Synergy and provides you with 
information on the animation that you've created. It also lists static graphics on the page, and allows you 
to alter the z-depth of graphics and animations on the page. 

You must be working within the Graphics tab to access the Timeline window. 

Note: The Timeline window can be displayed when Preview mode is toggled. 
However, it cannot be edited until Preview mode is turned off. 

 

Figure 14: The Timeline Window 

 

• Current Stage 
The Current Stage section provides you with the stage number for the currently selected stage. 

• Stage Duration 
The Stage Duration section indicates the total number of stages in your staged animation.  

• Acceleration 
There are three options in the Acceleration section: None, Slow Down, and Speed Up. Note that 
changing the acceleration affects the speed at which each stage of the animation plays; however, 
it does not affect the duration of the animation. 

• Show Stages checkbox 
You use the Show Stages checkbox to control the visibility of the Stages in an animation. Select 
this checkbox to see the stages of an animation outlined in the Graphics area when the animation 
isn't selected. This is useful when there is more than one animation on the page.  

• Show All checkbox 
By default, only the graphics associated with the currently selected page element are listed in the 
Timeline window. You select the Show All checkbox if you need to view a list of all of the graphics 
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that have been added to the page, not just those associated with the current page element. This 
is especially useful if you need to change the z-depth of the graphics on a page. 

You can right-click any graphic within the Timeline window to access a shortcut menu that allows you to 
lock and unlock graphics, show and hide graphics in the graphics area, and replace graphics. 

 

Figure 15: Shortcut menu in the Timeline Window 

 

Accessing the Timeline window 
1. Select View - Show Window - Timeline. 
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The Select tab 
The Select tab is located in the Outline pane. It allows you to select specific parts of a page, such as text 
items or steps, as well as selecting specific graphics. When you select a page element, the text and 
graphics associated with that element appear in the Graphics area. Before you can work on a particular 
part of a page, such as a specific text item, you must first select it in the Select tab. 

Note: In most templates, you can also navigate to the next or previous element on 
a page using the Buildable arrows in the WYSIWYG toolbar.  
When working with hotspots, you must press Shift+Click to activate the hotspot.  

 

Figure 16: The Select Tab 
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The WYSIWYG toolbar 
The WYSIWYG (What you see is what you get) toolbar provides access to the Preview Mode function in 
the Graphics tab. This toolbar is available in both the main toolbar area, and in the Select tab. 

 

Figure 17: The WYSIWYG toolbar 

• Toggle Preview Mode button 
The Toggle Preview Mode button allows you to view the page as it would appear in the Player. 
Any animations or interactivity in the page functions in the same way that they would if the page 
were viewed in the Player. 

• Next Buildable button 
The Next Buildable button allows you to navigate to the next buildable item on the page, for 
example, the next text item, list item, or piece of dialog. 

• Previous Buildable button 
The Previous Buildable button allows you to navigate to the previous buildable item on the page.  

• Toggle Captions button 
The Toggle Captions button allows you to view the Caption field in a Caption template, such as 
the Expos Caption, or List Caption templates. 

• Reset Page button 
The Reset Page button resets the page, undoing any interactions, and displaying it as it appears 
when it first opens in the Player. 
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4. Common tasks in the Graphics Tab 

Altering grid size 
The grid in the graphic area of the Graphics tabbed page allows you to align elements on the page.  

 

Figure 18: Graphics pane with grid 

Altering Grid Scale 
1. Right-click the grid to display the Graphics tab shortcut menu. 

2. Select Grid Scale and select a grid size from the expanded list of options; from 5 pixels per 
row/column to 30 pixels per row/column. 

Altering grid properties 
Using the right-click menu: 

1. Right-click the grid to display the Graphics tab shortcut menu. 

2. Select Grid Options. 

a. Toggle Display Grid to turn on or off the grid.  

b. Toggle Snap Object To Grid to snap any element in the graphics container to the grid 
when dragged. 

Graphics Tab Manual Visual_Design_Graphics_Tab_Manual 
Last saved by: Ray Cunningham Date: 07 August 2014 Page 23 of 177 

 



 

Figure 19: Grid options on the shortcut menu 

Specifying Graphics Grid Options 
Using the Tools menu: 

1. Select Tools – Options. 

2. In the View section, select Graphics Grid. 

a. To change the cell size, select a size from the Cell Size drop-down menu. 

b. To snap any element in the graphics area to the grid when dragged, select the Snap-to 
checkbox. 

c. To turn on the grid, select the Display Grid checkbox. 
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Figure 20: The Options Window 

Adding graphics 
To add graphics to a page using the Graphics tab, complete these steps: 

1. If the Select tab is active, select the page element to which you wish to assign the graphic from 
the Select Item drop-down menu. 

2. Right-click the grid to display the Graphics tab shortcut menu. 

3. Select Add Graphic from the shortcut menu. (Alternatively, press Alt+G.) 

4. Browse to the required graphic in the Add Graphic dialog box.  

5. Click Open. 

This adds the graphic to the page and automatically assigns it to Show with the item selected in the Select 
Item drop-down menu. 

Removing graphics 
1. Right-click the graphic you wish to remove.  

2. Select Delete Graphic from the shortcut menu which appears. 

 

Adding Graphic Text 
To determine what Graphic Text is required, if any, you complete these steps: 

1. Select View – Show Window – Graphic Direction. 

2. Select each page element in turn from the Page Element drop-down menu. 
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3. If a page element requires Graphic Text, a Graphic Text field appears below the Alt Text field. 

4. If there is more than one piece of Graphic Text associated with a page element, the Previous and 
Next buttons in the Graphic Text section are enabled, allowing you to navigate through the 
Graphic Text. 

5. When creating a piece of Graphic Text, you must ensure that the capitalization and spelling used 
match that given in the Graphic Text field exactly. 

Note: For more information on using Graphic Text refer to the Narrated Animation 
guidelines; in particular, you should refer to the Narrated Animation: Writing 
Graphic Text guideline. 

 

Adding and removing a background graphic 
Background graphics are static images used to frame a single or collection of Regular graphics. These 
could be a pattern using shapes and/or colors, or they could consist of a backdrop to give content to a 
scenario. Background graphics will have no ability to animate or to be interacted with. Background 
graphic size should always be set to 796px by 457px.  

Note: You should never add screengrabs as background graphics. Screengrabs 
should only ever be added using the regular Add Graphic option. 

Adding a background graphic 
1. Right-click the grid to display the Graphics tab shortcut menu. 

2. Select Add Background Graphic - To Page. 

3. Browse to the required graphic in the Add Graphic dialog box.  

4. Click Open. 

 

This adds the background graphic to the current page and to all subsequent pages in the current learning 
point. The background graphic is not added to subsequent learning points in the topic or subsequent 
topics.  

You can add a maximum of six different background graphics per topic. 

 

Removing a background graphic 
1. Right-click the grid to display the Graphics tab shortcut menu. 
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2. Select Delete Background Graphic - From Page. 

If you remove the background graphic from a page, all background graphics are removed from 
subsequent pages in the learning point even if those pages use different background graphics. 
Subsequent learning points and topics are not affected. 

Note:  

As of Synergy 1.15, background graphics are not supported in test questions. Background 
graphics are still supported in practice questions (questions that are located within learning 
points). For test question templates that support background graphics for the graphics area as 
well as the full page, only the ability to add background graphics to the full page is disabled in 
test questions. It is still possible to add graphic area background graphics. 

Using Highlighters and Pointers 
The colors of the highlighters and pointers used can be specified at course level. See 1. Setting up graphics 
properties for a course 

The difference between a highlighter and a pointer 
The difference between highlighters and pointers is clear cut. 

Highlighters draw the students’ attention to a particular area or areas on an application screengrab. They 
can be used in many Synergy templates, but are primarily used in the Expos template. Multiple 
highlighters can be used on pages. They are variable in size and can be used to highlight a single item or 
many items. They are non-interactive. The writer will provide guidance on where to place highlighters. 

Dynamic Pointers are animated arrows, and are only available for use in Try-Its. They are used to draw 
attention to single items, specifically the first interactive item in a Try-It. Pointers are always used in 
conjunction with a hotspot over the first interactive item in a Try-It. 

Note: Synergy also allows you to add static pointers to some page types. However, 
these are no longer in use in standard IT content from September 2009. 

Basic formatting of highlighters and pointers 
Synergy provides functionality to alter the color of both highlighters and pointers. The Team Lead or 
Senior Designer is responsible for setting up the highlighter and pointer colors. Typically, highlighters and 
pointers will use the same colors. The color choice is made only once, and should be consistent across an 
entire path. 

Highlighters 
Highlighters are semi-transparent blocks, colored yellow by default, which can be resized and positioned 
onscreen over the element that you want to draw attention to.  
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Figure 21: Page design using highlighters 

 

Adding a Highlighter 
1. Right-click the grid to display the Graphics tab shortcut menu. 

2. Select Add Highlighter – Area. 

3. Click and drag the highlighter to move it to the area that you wish to highlight. 

Resizing a Highlighter 
1. Select the Highlighter you wish to resize. (When the highlighter is selected, the outer edge 

appears as a red border). 

2. Click and drag the edge of the highlighter until it fits the element that you want to highlight. 

Deleting a Highlighter 
1. Select the Highlighter you wish to delete.  

2. Right-click the highlighter and select Delete Highlighter from the Graphics tab shortcut menu. 

Pointers 
Pointers are arrows that you can use to point directly to the element or elements being discussed. 
Synergy provides two types of pointers: Static and Dynamic. 
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Static pointers are arrows and arrow heads that can be positioned onscreen to indicate the element being 
discussed. They can be large or small, and point left, up, down or right. 

 

Note: Static Pointers are still available in the Synergy interface. However, from 
September 2009, they are no longer used in CCA IT Content. 

 

Dynamic pointers are animated to draw extra attention to an element to be clicked. They are used in the 
interactive Try It template. 

 

 

Figure 22: Page design using pointers 

Adding a Pointer 
1. Right-click the grid to display the Graphics tab shortcut menu. 

2. Select:  

a. Add Highlighter – Static Pointer (8 options available)* 

* Static pointers are no longer in use in standard IT content from September 2009 onwards. 
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b. Add Highlighter – Dynamic Pointer (4 options available) 

3. Click and drag the pointer to place it next to the desired page element. 

Assigning Static Pointers* 
Static pointers are automatically assigned to show with whichever page element is selected in the Select 
Item drop-down menu when they are added. You should check that the pointer is assigned to show with 
the appropriate page element. You may also need to set it to hide with later page elements if necessary. 

Assigning Dynamic Pointers 
Dynamic pointers are not assigned to anything by default. This means that when you add a dynamic 
pointer, it is not displayed onscreen until you assign it to something. Dynamic pointers must be assigned 
to the hotspot to which they point. In most cases, this is Hotspot S1-C1 in a Try It. So generally, you must 
set the Dynamic pointer to show for Hotspot S1-C1. You do not need to set a dynamic pointer to hide. It 
does this automatically when the hotspot with which it is associated is clicked. 

Deleting a Pointer 
1. Right-click the Highlighter you wish to delete.  

2. Select Delete Graphic. 

Layering graphics using z-depth 
Graphic z-depth is the order in which multiple graphics appear on a page in Synergy. Generally, graphics 
will be layered in the order that you add them, with the first graphic that you add appearing towards the 
back and the subsequent graphics appearing on top of it. Graphics can be re-layered using z-depth. 

 

Figure 23: Layered graphics in the graphics area 

* Static pointers are no longer in use in standard IT content from September 2009 onwards. 
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Altering the z-depth 
You can alter the z-depth working within the graphics area, or using the Timeline Window. 

To alter the z-depth when working in the graphics area: 

1. Right-click the graphic you wish to work with. 

2. In the Graphics tab shortcut menu that appears, select: 

a. Bring Forward – to bring the selected graphic to the front of the graphics area, with all 
other graphics behind. 

b. Bring Forward One Level – to bring the selected graphic up one level in relation to the 
other graphics in the graphics area. 

c. Send Back - to bring the selected graphic to the back of the graphics area, with all other 
graphics in front. 

d. Send Back One Level - to bring the selected graphic back one level in relation to the other 
graphics in the graphics area. 

To alter the z-depth using the Timeline window: 

1. Open the Timeline window by selecting View – Show Window – Timeline. 

2. If the page contains multiple elements, select the Show All checkbox so that you can view all of 
the graphics that have been added to the page. Otherwise only the graphics associated with the 
element currently selected in the Item drop-down list in the Select tab are displayed. 

3. The order in which items are listed in the Timeline window reflects their z-depth, with the item 
listed at the top of the window being the item at the front. 

4. To change the z-depth order simply click-and-drag graphics to a new position, above or below 
other graphics in the Timeline window. 

 

Locking and unlocking graphics 
Graphics can be locked in place to prevent you from accidentally moving them out of position.  
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Figure 24: Locking graphics using the shortcut menu 

 

Locking a graphic 
1. Right-click the graphic you want to lock to display the Graphics tab shortcut menu. 

2. Select Lock Graphic (Alternatively, press Ctrl+L). 

 

When you have finished adding and positioning all of the graphics on the page, you should lock them all 
in place. Right-click anywhere in the graphics area, and select Lock All. 

 

Unlocking a graphic 
1. Right-click the graphic you want to unlock to display the Graphics tab shortcut menu. 

2. Select Unlock Graphic.  

Note:  

You can also lock and unlock graphics using a shortcut menu in the Timeline window. You can 
lock an individual graphic by clicking to the right of the graphic name, so the padlock appears, 
and click again to unlock. Or you can right-click to access the shortcut menu, which allows you 
to lock or unlock the other graphics on the page.  
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Copying and pasting graphics 
You can cut, copy, and paste a graphic or copy and paste the entire contents of a page using the Cut, 
Copy, Paste, Copy Contents, and Paste Contents options in the shortcut menu. 

 

Figure 25: Cutting a graphic using the shortcut menu 

 

 Copying and pasting a graphic 
1. Select the graphic you wish to copy and paste. 

2. Right-click the graphic and select Copy. 

3. Right-click the destination. 

4. Select Paste. 

 

Cutting and pasting a graphic 
1. Select the graphic you wish to cut and paste. 

2. Right-click the graphic and select Cut. 

3. Right-click the destination. 

4. Select Paste. 
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Selecting multiple graphic elements 
The Graphics tab allows you to select and move multiple graphics at once.  

 

 

Figure 26: Multiple graphics selected in the Graphics pane 

 

1. Click the first graphic you wish to select. 

2. Press and hold the Ctrl key, and then click to select other graphics on the page simultaneously. 

Note: A scale setting cannot be applied to all components at the one time. 
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Working with multiple text items on a page 
When there is more than one text item on the page you may wish to assign separate graphics to appear 
or hide with each text item.  

 

Figure 27: Assigning graphics to specific Text Items 

 

Note: The principles to assigning graphics are standard and can be applied across 
most page types.  

 

Assigning a graphic to a text item 
1. First, select the text item you wish to work with from the Item drop-down list in the Select tab. 

2. Add the graphic which you want to appear with this text item to the graphics area. 

3. In the Assign To tab, ensure the graphic that you added was automatically assigned to Show with 
the appropriate text item. The Show checkbox should be selected.  

4. Select the second text item you wish to work with from the Item drop-down list in the Select tab.  

5. Add the graphic which you want to appear with this text item to the graphics area. 

6. In the Assign To tab, ensure the graphic that you added was automatically assigned to Show with 
the appropriate Text Item. The Show checkbox should be selected.  
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You may want certain graphics to disappear when a text item is displayed. To do this, you can assign 
graphics to hide with specific text items.  

Hiding a graphic for a text item 
1. Select the page element (Text Item, List Item, etc.) you wish to work with from the Trigger Item 

drop-down list in the Assign To tab. 

2. Select the Hide checkbox for the graphic you wish to hide when that page element is displayed. 

Note: When you have finished assigning graphics to show or hide, you should 
always preview your page to ensure they display correctly. 

Assigning a graphic to a hotspot 
Some page types, such as Explore Graphics and SkillChecks facilitate a graphic change when the learner 
clicks a hotspot. To set this up, you must assign the graphic to Show for the hotspot. 

1. Press the Shift key and then click the hotspot. This enables you to work on the associated graphic 
for the hotspot. 

2. Add the graphic which you want to appear with this hotspot to the graphics area. 

3. In the Assign To tab, ensure the graphic that you added was automatically assigned to Show with 
the appropriate hotspot. The Show checkbox should be selected for the graphic you just added.  

4. Preview the page and click the hotspot to ensure that the associated graphic appears in response. 

 

Creating animations 
Animations are an integral to creating dynamic and visually appealing courses. There are two types of 
animations in Synergy – canned and staged. 

Applying canned animations 
You apply canned animations using the effects available in the Effects tab. There are five different types 
of effects that you can apply.  

• Fly 

• Wipe 

• Fade 

• Dissolve 

• Flash 
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You can also direct these effects, specifying the type of effect, and setting the interval where relevant. 

 

Applying a canned animation effect 
1. Select the graphic you want to apply an effect to. 

2. Click the Add button in the Show Effects section of the Effects tab. 

3. Select the desired effect from the Effect drop-down list. 

4. If appropriate, choose the direction you want associated with the effect.  (North, East, South, 
West) 

5. Select the effect type, In or Out if using the Flash effect.  

6. Specify the duration of the animation by selecting an option from the Duration drop-down list. 

7. Specify a delay if required by selecting an option from the Delay drop-down list. 

 

Preview the page to check that the effect has been applied properly. 

Creating staged animations 
A staged animation is the animation of a graphic element between a start and end point with the 
possibility of multiple points’ in-between. You use the graphics area and the Animation window to create 
staged animations in Synergy. The Timeline window lists animations as well as static graphics on a page. It 
displays information on the animation stages, duration, and acceleration, and allows you to modify those 
settings. See The Timeline window 
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Figure 28: Graphic with animated stages 
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Adding a stage to an animation 
1. Right-click the graphic that you wish to animate and select Add Stage. 

2. A blue marquee effect indicates the second stage of the animation – it is labeled “2” in the top 
left corner. The first stage of the animation is labeled “1” in the top-left corner. This is the start 
point of the animation. 

3. Click anywhere within the marquee for stage 2 and move it to the position you would like the 
graphic to be in at the end of that stage. 

4. You can add another stage at any point by right-clicking on a stage and selecting Add Stage. This 
adds a new stage directly after the stage that you right-clicked. 

Deleting stages from animations 
1. Right-click the stage that you wish to delete. 

2. Select Delete Stage. 

Triggering an animation to start 
You can trigger an animation to start automatically when a page item displays or when the learner 
interacts with a hotspot. If the animation is prompted (if there is an Animation prompt box telling the 
learner what to click to trigger the animation), then you must trigger the animation using the 
hotspot/label provided. 

To trigger the animation to begin when the learner clicks a hotspot/label: 

1. Position the hotspot over the appropriate graphic, as directed by the animation prompt or by the 
writer. If there is a label associated with the hotspot, position that so that it relates to the 
hotspot. 

2. Select the hotspot/label from the Trigger Item drop-down menu in the Assign To tab. 

3. Select the Start checkbox associated with the animation target.  

4. Preview the page to ensure the animation plays correctly. 

Note:  

If the writer has specified that an animation should be triggered using a hotspot, that hotspot 
will automatically be available in the Graphics tab, where it can be sized and positioned by the 
designer. Hotspots cannot be added in the Graphics tab. 

To trigger the animation to begin when a particular page element is displayed: 

1. Select the page element in question from the Trigger Item drop-down menu in the Assign To tab. 

2. Select the Start checkbox associated with the animation target. 
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3. Preview the page to ensure the animation plays correctly. 

Animating along a curved line rather than a straight line 
By default, when you animate a graphic it animates along a straight line, from one stage to the next. 
However, it is also possible to animate along a curved line. 

1. Right-click the stage that you wish to animate along a curved line. (You must ensure that you 
right-click the first stage. For example, in a three stage animation, if you wish to animate the 
movement from stage 2 to stage 3 along a curved line, you must right-click stage 2 to do so.) 

2. Select Path Type - Bezier. 

3. Click and drag the circle that appears to change the shape of the curved line. 

 

Figure 29: Animation with Bezier path type 

 

Graphics Tab Manual Visual_Design_Graphics_Tab_Manual 
Last saved by: Ray Cunningham Date: 07 August 2014 Page 40 of 177 

 



Using the Timeline window to modify a staged animation 
The Timeline window allows you to control when an animation starts or ends, and how long it plays for. 
Each stage of the animation is represented by a black dot in a keyframe. Red keyframes indicate the 
keyframes for which the animation plays. The numbers (1, 2, 3, etc.) on the Timeline indicate number of 
seconds, and each frame is 1/12th of a second. 

 

Figure 30: Animations in the Timeline window 

You can click and drag the keyframe associated with a stage to change its position on the timeline. In this 
way, you can set animations to run concurrently, consecutively, or set one animation to begin as another 
is ending. You can also change the duration of an animation by clicking and dragging the end keyframe to 
lengthen or shorten it. If you right-click the Timeline area of the Timeline window, a shortcut menu 
appears providing you with the options to add a stage or delete a stage from an animation. 

 

Figure 31: Adding and deleting Stages using the Timeline window 
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Working with code-enabled templates 

Code-enabled templates 
The following templates facilitate the display of code: 

• Expos 

• List 

• Explore List 

• Explore Graphic 

• Explore Code* 

• Multiple Choice Standard 

• Multiple Choice Fill-in Code* 

• Short Answer Graphic 

• Short Answer Text  

• Question Set 

The Writer inputs code or syntax into the Code Editor in the Writing tab. This code or syntax then appears 
in the Graphics tab, where the designer can position it or resize it if necessary. 

Code appears in the Graphics tab as a moveable graphic object, which can be resized as required. 
Generally, the writer will set the background of the code to white for standard coding topics, or to black 
for command-line content. If the code is to be used in conjunction with a screengrab, the writer may set 
the code background to transparent. This enables the designer to position the code over the screengrab, 
making it appear as though the code exists within the interface shown in the screengrab. 

Syntax is displayed in the Graphics tab within a Syntax box. You work with the Syntax box in the same way 
that you would work with a Keyboard Sequence, Note, or Launch box. You simply position it onscreen in 
an appropriate area. 

Tasks 
In most code-enabled templates, as well as the normal Graphics tab tasks for those templates, the coding 
tasks you need to complete are as follows: 

• Positioning Syntax boxes 

* The Explore Code and the Multiple Choice Fill-in Code templates are specifically designed for use with code, so 
these templates are described individually in Section 5. The coding features of all other templates are defined in the 
general tasks and steps outlined in this section. 
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• Positioning any code, taking account of whether or not the code grows  

• Resizing the code area if necessary 

• Positioning highlighters or pointers on top of the code area to emphasize particular pieces of 
code, as directed by the Writer 

Steps 
To work with a Syntax box in the Graphics tab, you complete these steps: 

1. Select the page element with which the Syntax box is associated from the Item drop-down list in 
the Select tab 
(This step is unnecessary when the page in question only has a single page element, or if the 
Select tab is disabled.) 

2. Drag-and-drop the Syntax box to the required position, ensuring that it does not obscure any 
important graphics or code in the background 

3. If a number of Syntax boxes occur on a single page, or in a number of pages in a row, ensure they 
are aligned 

4. When working with Code on a page, you must first determine whether or not the Code grows. 
The positioning of the code area is dependent on whether or not it grows. To determine whether 
or not the code grows, you follow these steps: 

5. Select each page element in turn from the Item drop-down list in the Select tab 

6. When each page element is selected, observe whether the code associated with the page 
element occurs on its own, or together with another piece of code 

7. If a piece of code occurs on its own, you should position it wherever you deem appropriate 

Note:  

You should position the code so that it is not obscured by anything onscreen, and is easily read 
by the learner. If there are two or more pieces of code being shown individually in successive 
steps, you should position each piece of code with the same X,Y coordinates, so that it appears 
to the learner that one piece of code replaces another. 

8. If a piece of code occurs together with another, you should position the second piece of code 
directly beneath the first, making it appear as though the second piece of code is building on the 
first 

Note: To line the pieces of code up exactly, ensure that the X coordinate of each 
piece of code is the same. 
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9. Preview the page to ensure that the code is lined up correctly and appears to build up onscreen 
as you move through the buildable items 

10. Add highlighters or pointers if directed to do so by the writer – usually, however, the writer adds 
highlighting within the Code Editor itself, so this step is unnecessary  

11. To resize code, you complete the following steps: 

12. Position the cursor over the outer edge of the code area until it changes to a double-headed 
arrow 

13. Click-and-drag the edge of the code area to resize it 

Note:  

When resizing the code area, it is important that you do not alter the line wrapping for the 
code. Altering the line wrapping may introduce errors or cause problems with legibility. So 
when clicking-and-dragging the edge of the code area, you must watch the code lines carefully 
to ensure that none of the code wraps on to the next line. 
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5. Working with page templates  

Introduction 
The aim of this section is to give a brief overview of the purpose of each template and to describe tasks 
that are specific only to that template.  

Note: The processes for working in the Graphics tab are standard across most 
templates. If a specific process is required for an individual template, that process 
is outlined in this section. Otherwise, you should assume that basic tasks, such as 
adding, showing, and hiding graphics, are all carried out in that template as 
described in Section 4 of this document. 
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Expos 

 

Figure 32: An Expos page in the Graphics tab 

 

Figure 33: A published Expos page 
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Overview 
The Expos template is used to present content in a non-interactive manner. It is the most common page 
type. It contains between one and three Text items. Each Text item can contain one or more paragraphs. 
Each Text item may be accompanied by a graphic that illustrates the Text item’s content. You can 
associate an animation with a Text item in an Expos template. 

Tasks 
Tasks that you may be required to carry out when developing an Expos page include: 

• Adding a background graphic 

• Adding and positioning graphics 

• Assigning graphics to show or hide with one or more Text items 

• Adding highlighters or pointers 

• Positioning text boxes, launch boxes, syntax boxes, and keyboard sequence boxes in Draggable 
pages 

• Assigning graphic effects 

• Creating basic staged animations 

• Creating prompted animations 

• Positioning code 

Steps 
The following is the recommended sequence of steps that you should follow when building a basic Expos 
page: 

1. Read the content, including any graphic direction provided 

2. Determine the number of Text items on the page 

3. If necessary, add a background graphic if one has not already been applied 

4. Add and position any graphics for the first Text item 

5. If there are multiple Text items on the page, select each in turn from the Item drop-down list in 
the Select tab (or use the Buildable arrows in the WYSIWYG toolbar), and then add the graphics 
for that Text item 

6. Check the Image memory tab once the graphics have been added to the page and ensure that 
the ‘Size on Disk’ value is not over 100k, and that the ‘Size in Memory’ value does not exceed 
12288kb 

7. Set graphics to hide with later Text items if necessary 
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8. If the page is Draggable, position the text boxes, launch boxes, syntax boxes, etc. 

9. Lock all elements into place 

10. Preview the page 

If the page includes code, you must also position the pieces of code for each Text item.  

If transition effects are required, you must apply them to the graphics. If the page requires a staged 
animation, you need to add stages to the graphic to be animated, and set up the animation. 

 

Figure 32: A developed Expos Caption page in the Graphics tab 
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Expos Caption 

 

Figure 33: A published Expos Caption page 

Overview 
An Expos Caption template is used in Narrated Animation instead of the standard Expos template. It 
performs the same instructional function as the standard Expos templates, but uses full screen visuals 
and may include Graphic Text (text in the form of visuals or graphics). Also, rather than onscreen text, the 
narrative text is presented in Captions, which can be hidden from view, or displayed across the bottom of 
the screen, depending on the learner’s preference. 

Tasks 
The process for developing an Expos Caption is identical to that for developing a standard Expos template 
with two exceptions – you must allow room for the Caption field, and you may be required to add Graphic 
Text.  
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List 

 

Figure34: A developed List page in the Graphics tab 

 

Figure 35: A published List page 
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Overview 
The List template is another non-interactive template. A list consists of a single Text item, which includes 
an optional introductory paragraph and the list lead-in, and two or more List items. The List items can be 
bulleted or numbered, and they can build one-by-one on screen (a build list) or appear all at once (a 
nonbuilding or static list). A graphic accompanies the Text item within a nonbuilding list. In a building list, 
a graphic change may accompany the Text item and each individual List items.  

Tasks 
Tasks that you may be required to carry out when developing a List page include: 

• Adding a background graphic 

• Adding and positioning graphics 

• Assigning graphics to show or hide with the Text item and the buildable List items 

• Adding highlighters or pointers 

• Positioning text boxes, launch boxes, syntax boxes, and keyboard sequence boxes in Draggable 
pages 

• Assigning graphic effects 

• Creating basic staged animations 

• Creating prompted animations 

• Positioning code 

Steps 
The following is the recommended sequence of steps that you should follow when building a List page: 

1. Read the content, including any graphic direction provided 

2. Determine whether the page is building or non-building 
(If the page builds, the Text item and each individual List item will be listed in the Item drop-
down list in the Select tab. If the page is static, only the Text item will be listed in the Item drop-
down list.) 

3. If necessary, add a background graphic  

4. Add and position any graphics for the introductory Text item 
(If it is a non-building, non-draggable page, you should be ready to preview it after completing 
this step) 

5. If the List items build on the page, select each in turn from the Item drop-down list in the Select 
tab, and then add the graphics for that List item once it has been selected 
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6. Check the Image memory tab once the graphics have been added to the page and ensure that 
the ‘Size on Disk’ value is not over 100k, and that the ‘Size in Memory’ value does not exceed 
12288kb 

7. Set graphics to hide with later List items, if necessary 

8. If the page is Draggable, position the text boxes, launch boxes, etc. 

9. Lock all elements into place 

10. Preview the page 

If the page includes code, you must also position the pieces of code for the Text item and the buildable 
List items. 

If transition effects are required, you must apply them to the graphics. If the page requires a staged 
animation, you need to add stages to the graphic to be animated, and set up the animation. 

List Caption 

 

Figure 36: A developed List Caption page in the Graphics tab 
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Figure 37: A published List Caption page 

Overview 
A List Caption template is used in Narrated Animation instead of the standard List template. It performs 
the same instructional function as the standard List templates, but uses full screen visuals and may 
include Graphic Text (text in the form of visuals or graphics). Also, rather than onscreen text, the narrative 
text is presented in Captions, which can be hidden from view, or displayed across the bottom of the 
screen, depending on the learner’s preference. 

Tasks 
The process for developing a List Caption is identical to that for developing a standard List template with 
two exceptions – you must allow room for the Caption field, and you will likely be required to add graphic 
text.  
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Explore List 

 

Figure 38: A developed Explore List page in the Graphics tab 

 

Figure 34: A published Explore List page 
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Overview  
The Explore List is an interactive template. It presents a text introduction and a list of items. Associated 
with each List item is a text explanation and/or graphic change. The graphic change can take the form of a 
graphic or an animation. The learner clicks each List item to read and view the text and/or graphic change 
associated with it.  

Tasks 
Tasks that you may be required to carry out when developing an Explore List page include: 

• Adding a background graphic 

• Adding and positioning graphics 

• Assigning graphics to show or hide with one or more List items 

• Adding highlighters and pointers 

• Positioning text boxes, launch boxes, and syntax boxes in Draggable pages 

• Assigning graphic effects 

• Creating basic staged animations 

• Positioning code 

Steps 
The following is the recommended sequence of steps that you should follow when building an Explore List 
page: 

1. Read the content, including any graphic direction provided 

2. Determine whether or not the List items have associated graphics  

3. Add a background graphic if one has not already been applied 

4. Add and position any graphics for the introductory Text item 
(If it is a non-draggable page, with no graphic changes for each List item, you should be ready to 
preview it after completing this step) 

5. If there are graphic changes with each List item on the page, select each in turn from the Item 
drop-down list in the Select tab, and then add the graphics for that List item once it has been 
selected 

Note:  

When you click each List item in the Graphics tab, the associated text for that List item appears. 
However, the item selected in the Select tab does not change. To add a graphic to a particular List 
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item, you must first ensure that the specific List item is selected in the Item drop-down in the 
Select tab. 

6. Check the Image memory tab once the graphics have been added to the page and ensure that 
the ‘Size on Disk’ value is not over 100k, and that the ‘Size in Memory’ value does not exceed 
12288kb 

7. Graphics and Text associated with individual List items should automatically hide when that List 
item is closed 

8. If the page is Draggable, position the text boxes, launch boxes, etc. 

9. Lock all elements into place 

10. Preview the page 

If the page includes code, you must also position the code for the Text item. In an Explore List page, the 
writer can only add Code or Syntax to the introductory Text Item. It is not possible for the writer to 
associate code with each List item. 

If transition effects are required, you must apply them to the graphics. If the page requires a staged 
animation, you need to add stages to the graphic to be animated, and set up the animation. 
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Explore Graphic 

 

Figure 40: A developed Explore Graphic page 

 

Figure 41: A published Explore Graphic page 
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Overview 
The Explore Graphic is an interactive template, which presents a text introduction and two or more 
graphic hotspots. Hotspots are defined by the Instructional Writer and added via the Writing tab. A 
hotspot is an “invisible” element associated with a particular graphic or area of a graphic. It may have an 
associated Label. If the Instructional Writer chooses to publish the Label, it will be visible within the 
Graphics area. The learner can either click the hotspot or the label to receive its associated material. The 
associated material may be text only, or may include any combination of graphics, animations, code, or 
syntax. 

Tasks 
Tasks that you may be required to carry out when developing an Explore Graphic page include: 

• Adding a background graphic 

• Adding and positioning graphics 

• Positioning and resizing hotspots 

• Positioning labels 

• Positioning code 

• Assigning graphics to show or hide with one or more hotspot/labels 

• Positioning text boxes, launch boxes, syntax boxes, and keyboard sequence boxes in Draggable 
pages 

• Assigning graphic effects 

• Creating basic staged animations 

• Converting hotspots to highlighters 

Steps 
The following is the recommended sequence of steps that you should follow when building an Explore 
Graphic page: 

1. Read the content, including any graphic direction provided 

2. Add a background graphic if necessary 

3. Add and position any graphics for the introductory Text item 

4. Position the hotspots over the appropriate graphics or graphic sections, and if the labels are 
published, position them as appropriate 

5. If there are graphic changes with each hotspot/label on the page, press and hold the Shift key 
and then click each hotspot in turn. When you Shift+click a hotspot, you can then add the 
associated graphics for that hotspot 
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6. Check the Assign To tab to ensure that the graphic that you added is set to Show for the 
required hotspot 

7. If the labels are published, you must manually set the associated graphics to show for the label 
by selecting the label from the Trigger Item drop-down list in the Assign To tab, and then 
selecting the Show checkbox for the associated graphic 

Note:  

Hotspots and labels in the Explore Graphic template are treated as graphics and therefore, they 
are not available in the Item drop-down in the Select tab. For this reason, you must Shift+click 
each hotspot/label before you can work in the graphic view that the learner sees when they 
click that hotspot or label. Once you have Shift+clicked a hotspot, any graphics that you add 
should automatically be set to show for that hotspot. However, you will then have to manually 
set that graphic to show for the associated label using the Assign To tab. 

8. If you include an associated graphic change for one hotspot, you must include an associated 
graphic change for all hotspots 

Note: The maximum number of graphic changes permitted is five. This is to ensure 
that the page size remains within acceptable limits. 

9. Check the Image memory tab once the graphics have been added to the page and ensure that 
the ‘Size on Disk’ value is not over 100k, and that the ‘Size in Memory’ value does not exceed 
12288kb 

10. Items associated with individual hotspot/labels should automatically hide when the associated 
text for that hotspot/label is closed 

11. If the page is Draggable, position the text boxes, launch boxes, etc. 

12. Lock all elements into place 

13. Preview the page 

If the page includes code, you must also position the code for the Text item or associated with the 
Hotspot/Labels. In an Explore Graphic page, the writer can add Code or Syntax to the introductory Text 
Item and also to each hotspot/label.  

If transition effects are required, you must apply them to the graphics. If the page requires a staged 
animation, you need to add stages to the graphic to be animated, and set up the animation. 

Tasks specific to the Explore Graphic template 

Positioning and resizing of hotspots 
To position the hotspot  
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• Select the hotspot and drag it to its new location 

To adjust the size of the hotspot 

• Roll your cursor over any of the four edges of the hotspot to change it to a scale icon 

• Click and drag to make the hotspot bigger or smaller 

Note: Hotspots cannot be smaller than 16x16 pixels, for usability reasons. 

You can lock or unlock a hotspot’s position on screen by following the Locking and unlocking graphic 
methodologies outlined in section 4.  

Working with Associated material 
To view a hotspot/label’s associated material and any graphics that may appear when the learner clicks a 
hotspot or label: 

• Hold the Shift key and click the hotspot or label 

The associated material may include text, graphics, animations, or code. If you add an associated graphic 
for a hotspot/label, you must add an associated graphic for all hotspot/labels on the page. It is not 
acceptable to have graphic changes for some hotspot/labels but none for others on a page. 

Explore Graphic Caption  

Explore Graphic Caption: Overview 
An Explore Graphic Caption is used in some content such as Expert Learning. It performs the same 
instructional function as the standard Explore Graphic templates, but uses full screen visuals and may 
include Graphic Text (text in the form of visuals or graphics). Also, rather than onscreen text, the narrative 
text is presented in Captions, which can be hidden from view, or displayed across the bottom of the 
screen, depending on the learner’s preference. 

Tasks 
The process for developing an Explore Graphic Caption is identical to that for developing a standard 
Explore Graphic template with three exceptions – you do not need to position associated text because it 
appears in the Caption area, you must allow room for the Caption field, and you may be required to add 
Graphic Text.  
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Explore Code 

 

Figure 42: A developed Explore Code page in the Graphics tab 

 

Figure 43: A published Explore Code page 
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Overview 
The Explore Code is an interactive template, which presents a text introduction and a piece of code 
containing two or more hotspots. These hotspots on the code are set up by the Writer and associated 
with the Code Associated Text (pop-up text) in the Code Editor. The learner can click the hotspot to 
receive its associated text. 

Tasks 
Tasks that you may be required to carry out when developing an Explore Code page include: 

• Adding a background graphic 

• Adding and positioning graphics 

• Positioning code 

• Positioning Syntax boxes 

• Positioning the Text Item box, Code Associated Text boxes, and Launch boxes in Draggable pages 

• Assigning graphic effects 

• Creating basic staged animations 

Steps 
The following is the recommended sequence of steps that you should follow when building an Explore 
Code page: 

1. Read the content, including any graphic direction provided 

2. Add a background graphic if one has not already been applied 

3. Add and position any graphics for the introductory Text item 

4. Check the Image memory tab once the graphics have been added to the page and ensure that 
the ‘Size on Disk’ value is not over 100k, and that the ‘Size in Memory’ value does not exceed 
12288kb 

5. Position any code and Syntax boxes 

6. If the page is Draggable, press and hold the Shift key and then click each hotspot in turn 

7. When you Shift+click a hotspot, you can then view and position the Code Associated Text for 
that hotspot 

8. If the page is Draggable, position the text boxes, launch boxes, etc. 

9. Lock all elements into place 

10. Preview the page 
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If transition effects are required, you must apply them to the graphics. Or if the page requires a staged 
animation, you need to add stages to the graphic to be animated, and set up the animation. 

 

Tasks specific to the Explore Code template 

Working with Associated material 
To view a hotspot’s associated text that may appear when the learner clicks a hotspot or label: 

• Hold the Shift key and click the hotspot or label 

The associated material may include text only. It is not possible to add graphics as associated changes in 
an Explore Code page.  
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Drilldown Draggable 

 

Figure 44: A developed Drilldown base page 

 

Figure 45: A published Drilldown base page 
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Figure 46: A developed Drilldown child page 

 

Figure 47: A published Drilldown child page 

 

Overview 
The Drilldown is an interactive template, which presents a base page and a series of child pages. The base 
page is similar to an Explore Graphic in that it contains a text introduction and two or more graphic 
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hotspots. Hotspots are defined by the Instructional Writer and added via the Writing tab. A hotspot is an 
“invisible” element associated with a particular graphic or area of a graphic. It may have an associated 
Label. If the Instructional Writer chooses to publish the Label, it will be visible within the Graphics area. 
The learner can either click the hotspot or the label to open the child pages associated with that hotspot. 
The child pages may take the form of Expos pages or List pages. 

Tasks 
When developing a Drilldown, you need to develop the base page as well as a series of child pages. Tasks 
in developing the Drilldown (base) page may include: 

• Adding a background graphic 

• Adding and positioning graphics 

• Positioning and resizing hotspots 

• Positioning labels 

• Positioning code 

• Positioning text boxes, syntax boxes, and keyboard sequence boxes 

• Assigning graphic effects 

• Creating staged animations 

Tasks in developing each Drilldown child page are dependent on whether that child page is an Expos page 
or a List page. You should refer to the sections on developing Expos pages and List pages for more 
information on these types of pages. The only difference between developing a child page and the 
standard version of these pages is that the Drilldown border appears in the child page versions. 

Steps 
The following is the recommended sequence of steps that you should follow when building a Drilldown 
base page: 

1. Read the content, including any graphic direction provided 

2. Add a background graphic if necessary 

3. Add and position any graphics for the introductory Text item 

4. Position the hotspots over the appropriate graphics or graphic sections, and if the labels are 
published, position them as appropriate 

5. Check the Assign To tab to ensure that all graphics that you add are set to Show for the 
introductory Text item 
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Note: You cannot assign graphics to show with the individual hotspots or labels 
because when the learner clicks those hotspots or labels, the associated set of child 
pages displays instead. 

6. Check the Image memory tab once the graphics have been added to the page and ensure that 
the ‘Size on Disk’ value is not over 100k, and that the ‘Size in Memory’ value does not exceed 
12288kb 

7. Lock all elements into place 

8. Preview the page using Full Preview or Quick Preview 

If the page includes code, you must also position the code for the Text item.  

 

Tasks specific to the Drilldown template 

Positioning and resizing of hotspots 
To position the hotspot  

• Select the hotspot and drag it to its new location 

To adjust the size of the hotspot 

• Roll your cursor over any of the four edges of the hotspot to change it to a scale icon 

• Click and drag to make the hotspot bigger or smaller 

Note: Hotspots cannot be smaller than 16x16 pixels, for usability reasons. 

You can lock or unlock a hotspot’s position on screen by following the Locking and unlocking graphic 
methodologies outlined in Section 4.  
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HTML 
Some topics contain HTML pages, which are used to integrate HTML-based content into Synergy, such as 
Articles, Mentored Exercises, etc. Writers are responsible for integrating this content. Designers do not 
need to work with this page. 
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Sim Dialog 

 

Figure 48: A developed Sim Dialog Page in the Graphics tab 

 

Figure 49: A published Sim Dialog Page 
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Overview 
A Sim Dialog consists of a text introduction (a Text item) and a series of dialogs. As the Sim Dialog plays, 
the dialog appears in the text field. If the character labels are published, the character name appears 
beside each piece of dialog. Sim Dialogs (sometimes called Sim Dias or Simulated Dialogs) are written as 
either a one-to-one conversation or a discussion between a number of people. They can also be used for 
non-dialog purposes to build up a series of steps for example. They can include graphic changes as each 
character speaks or as each line of dialog is played. The Sim Dialog introduction text is generally used to 
introduce a scenario or set the scene. Therefore, the graphics that you use throughout the Sim Dialog 
should make sense in relation to the scenario referred to in the Sim Dialog introduction. Sim Dialogs that 
feature named characters should include graphics depicting a variety of realistic and appropriate facial 
expressions. 

Tasks 
Tasks that you may be required to carry out when developing a Sim Dialog page include: 

• Adding a background graphic to the page or to the Graphic area 

• Adding and positioning graphics 

• Assigning graphics to show or hide with each piece of dialog 

Steps 
The following is the recommended sequence of steps that you should follow when building a Sim Dialog 
page 

1. Read the content, including the graphic direction provided 

2. If necessary, add a background graphic if one has not already been applied 

3. Add and position any graphics for the introductory Text item 

4. Click the Next Buildable arrow in the WYSIWYG toolbar to display the first piece of Dialog 

5. If the Graphic for each dialog checkbox is selected in the Writing tab, you should add a graphic 
for the first piece of Dialog 

6. Click the Next Buildable arrow in the WYSIWYG toolbar to display the next piece of Dialog 

7. If the Graphic for each dialog checkbox is selected in the Writing tab, you should add a graphic 
for the next piece of Dialog 

8. Repeat these steps until you have added graphics for each piece of Dialog if necessary 

9. Check the Image memory tab once the graphics have been added to the page and ensure that 
the ‘Size on Disk’ value is not over 100k, and that the ‘Size in Memory’ value does not exceed 
12288kb 
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10. For each piece of dialog on the page, select each in turn from the Trigger Item drop-down list in 
the Assign to tab, and then check that the appropriate graphics are set to show for each Dialog 
item 

11. Add Show effects or Hide effects for each graphic if required 

12. Graphics associated with individual Dialog items should automatically hide when next Dialog 
item is displayed 

13. Preview the page 

Tasks specific to the Sim Dialog template 

Adding graphics 
In the Writing tab, the Writer specifies whether the graphics should be on the left or the right of the page 
by selecting either the Graphic Left or the Graphic Right radio button. When Graphic Left is selected, the 
graphics area is positioned on the left-hand side of the page, beneath the Text item and the Prompt. The 
size of the area is 375px by 207px. The Dialog is then displayed on the right-hand side of the screen. 

When Graphic Right is selected, the graphics area is positioned on the right-hand side of the page, taking 
up half the page. The size of the area is 375px by 375px. The Dialog is then displayed on the left-hand side 
of the screen, beneath the Text Item and the Prompt. 

The Sim Dialog template allows you to add Full Screen graphics, which are centered in the graphics area 
by default. The maximum size of these graphics is determined by whether the page is set to Graphic Left 
or Graphic Right. If you add a Full Screen, or centered, graphic to the introductory Text Item, then all 
other graphics on the page must be added as Full Screen graphics. You can only add one Full Screen 
graphic to each item on a page. 

Alternatively, you can choose to add Left or Right graphics. Again, the maximum size of these graphics is 
determined by whether the page is set to Graphic Left or Graphic Right. When you add a Left or Right 
graphic, it is left-aligned or right-aligned on the page, depending on which option you choose. If you add a 
Left or Right graphic to the introductory Text Item, then all other graphics on the page must be added as 
Left or Right Graphics. You can add one Left graphic and one Right graphic to each item on a page. 

To add a graphic to the Graphics area: 

1. Right-click the Graphics area 

2. Select Add Graphic to open the Add Graphic submenu 

3. Choose Left, Right, or Full Screen 

 

Previewing Dialog 
When you first preview a Sim Dialog in the Graphics area, the Dialog is hidden from view.  

To preview each piece of Dialog: 
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• Click the Next Buildable arrow in the WYSIWYG toolbar 

• Click the Previous Buildable arrow to traverse back through the dialog and bring the Sim Dialog 
back to its initial state 
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Sim Dialog Video Caption 
 

•  

Figure 50: A developed Sim Dialog Caption page in the Graphics tab (the published version is identical) 

•  

Overview 
A Sim Dialog Video Caption is used in Narrated Animation instead of the standard Sim Dialog template. It 
performs the same instructional function as the standard template.  

If video is enabled on the page, the conversation or dialog will be presented in video format. The audio is 
embedded in the video file.  

If video is disabled, the dialog will be presented as a series of static images, with accompanying audio.  

Regardless of whether video is enabled or disabled for the page, the narrative text is presented in 
Captions in the Player window, which can be hidden from view, or displayed across the bottom of the 
screen, depending on the learner’s preference. 

Tasks 
Tasks that you may be required to carry out when developing a Sim Dialog Video caption page include: 

• Adding and positioning graphics 

• Assigning graphics to show or hide with each piece of dialog 

• Integrating video 

• Editing the video timeline information 
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Steps for building a Sim Dialog Video Caption page with video enabled 
To build a Sim Dialog Video Caption page with video-enabled, you must complete these steps: 

1. Ensure that video is enabled on the page 

a. If video is not enabled on the page, select the Video checkbox to enable it. 

Note: An alert message will appear, warning that converting the current page to a 
video page will remove all current graphics, highlighters, code and syntax, as they 
are not compatible with the video page. Click Yes to continue and activate video on 
the page. 

b. If the video checkbox is disabled, you will first need to enable video at course level by 
editing the settings on the Video tab at the course node level. 

2. Integrate the video for the page 

3. Edit the video timeline data for the page 

4. Integrate the audio for the page 

5. Integrate the static graphic files for the page 

Note: To integrate the static graphic files for the page, follow the steps as given for 
building a Sim Dialog Video Caption page with video disabled. 

6. Preview the integrated page in video mode 
The page plays in video mode by default. If video is disabled, complete these steps to enable it: 

a. Click the Show Resources and Settings Dialog tab 

b. Select Settings 

c. In the Settings dialog box, clear the Turn Off Video checkbox and click OK 
If viewing the course map, the video icon on the course map becomes active, indicating 
the course will be played in video mode. 

7. Preview the integrated page in non-video mode 
To preview the non-video version of the video page: 

a. Click the Show Resources and Settings Dialog tab 

b. Select Settings 
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c. In the Settings dialog box, select the Turn Off Video checkbox and click OK 
If viewing the course map, the video icon on the course map becomes inactive, indicating 
the course will be played in non-video mode. 

8. Save your topic 

Tasks specific to the Sim Dialog Video Caption template 

Integrating Video 
The source for the video for Sim Dialog Video Caption pages is generally provided in MP4 format. This 
video must be edited in accordance with the Video Development guidelines, and published in a format 
suitable for integration into Synergy. 

To integrate video in a Sim Dialog Video Caption template, you must complete these steps: 

1. Identify the appropriate filename for the video file. The video filename field in the Writing Tab 
supplies the correct video filename, in the format topicnumber_vid_filenumber.  

 

Figure 35: Video information in the Writing tab of the Sim Dialog Video Caption page 

2. Identify the appropriate video format(s).  
If there are multiple video formats in the course, each file will have the same filename, but 
different file types. For example, the filename could be t6_vid_0178. If the course uses the flv 
format, the file would be saved as t6_vid_0178.flv. If the course also uses the mp4 format, 
the mp4 file would be saved as t6_vid_0178.mp4. 
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Note: The video formats that are supported in a given course are indicated on the 
Video tabbed page at course level.  

3. Publish the video files to the appropriate format(s) and rename them as per the name given in 
the Video Filename field in the Writing Tab. 

4. Using Windows Explorer, add the video files to a course by copying them to the media\video 
folder at the topic level of that course folder structure.  

 

Figure 36: Video folder in the Synergy course structure 

5. Save the course. 

6. Preview the Sim Dialog Video Caption pages to ensure the video has been integrated correctly. 

Integrating static images 
When a page is video-enabled, a static version of the page complete with static images must also be built, 
in case learners view the page with video disabled.  The static images must be stills taken from the video 
file. One image should be added for the caption field, and one for each dialog item. The static images 
should be the same size as the video file. Refer to the Video Development guidelines for detailed 
guidelines on the requirements for creating these images.  

Refer to the Steps for building a Sim Dialog Video Caption page with video disabled, for detailed 
instructions on incorporating static images into a Sim Dialog Video Caption page. 

Incorporating Graphic Text 
Whether or not video is enabled in the page, only one graphic may be added to each item (caption or 
dialog). If Graphic Text is required, it must be added to the image, and the image must be exported as a 
flattened file before it is added to the course.  

Integrating audio files 
The audio for the static version of the page must be exported from the source video file for the page. A 
separate audio file is required for each piece of dialog on the page. 
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The audio files must be named to match the filenames associated with each piece of dialog in Synergy. 
They should then be converted to SPX format and integrated into the course by adding them to the 
media\audio folder at the topic level of the course structure. 

Editing video timeline information 
On static Sim Dialog Caption pages, the audio files, images, and caption text are automatically 
synchronized. If the page contains video, the caption text must be synchronized manually.   

 

Figure 51: The Edit Video Timeline button  

The Edit Video Timeline button in the tab area is highlighted when timeline information is required.  

  

Figure 52: The Video Timeline window  

The Video Timeline window lists the dialog items on the page. The spin buttons allow you to set the time 
that each piece of dialog appears in the video. The first dialog item will almost always appear at 0 mins 
and 0 secs. Each dialog item must have a higher time value than the preceding item.   

 

Steps for building a Sim Dialog Video Caption page with video disabled 
The following is the recommended sequence of steps that you should follow when building a Sim Dialog 
Video Caption page with video disabled: 

1. Read the content, including the graphic direction provided  
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2. Add and position a graphic for the introductory Text item 

3. Click the Next Buildable arrow in the WYSIWYG toolbar to display the first piece of Dialog 

4. If the Graphic for each dialog checkbox is selected in the Writing tab, you should add a graphic 
for the first piece of Dialog 

5. Click the Next Buildable arrow in the WYSIWYG toolbar to display the next piece of Dialog 

6. If the Graphic for each dialog checkbox is selected in the Writing tab, you should add a graphic 
for the next piece of Dialog 

7. Repeat these steps until you have added graphics for each piece of Dialog if necessary 

8. Check the Image memory tab once the graphics have been added to the page and ensure that 
the ‘Size on Disk’ value is not over 300k, and that the ‘Size in Memory’ value does not exceed 
12288kb 

9. For each piece of dialog on the page, select each in turn from the Trigger Item drop-down list in 
the Assign to tab, and then check that the appropriate graphics are set to show for each Dialog 
item 

10. Graphics associated with individual Dialog items should automatically hide when next Dialog 
item is displayed 

11. Preview the page 
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Video Standard Caption  

Overview 

 

Figure 37: Developed Video Standard Caption page in the Player  

The Video Standard Caption template allows you to import video into Synergy. The template allows you 
to import videos of any size, up to a maximum of 768x432 pixels. The video plays as soon as the page 
opens, and there is no introductory static screen (unlike the Sim Dialog Video Caption page). If captions 
are enabled they display in the Caption area at the bottom of the Player window and are synchronized 
with the video.  

If video is disabled, then static images appear onscreen instead of the video. These graphics on screen 
may change with each chunk of text on the page. The text is still contained in the Caption area when 
video is disabled. 

The template may be used to display dialogs, monologs, or other non-dialogue content such as 
procedures etc.  
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The template my also include a link to an external HTML file on the page. The external file may be Topic 
Notes, Job Aids, or Learning Aids. The Launch Button bar, when selected, is automatically placed over the 
lower edge of the video, it cannot be repositioned.  

 

Tasks  
Tasks that you may be required to carry out when developing a Video Standard Caption page include:  

• Adding and assigning graphics  

• Adding the video files 

• Adding timeline information 

 
 

Steps  
The following is the recommended sequence of steps that you should follow when building a Video 
Standard Caption page: 

1. Read the content, including the graphic direction provided  

2. Add the video file to the course, renaming it to match the reference on the Writing tab 

3. Add timeline information in the Edit Video Timeline dialog (see the ‘Editing video timeline 
information’ subsection of the Sim Dialog Video Caption section for details) 

4. Take a static image for each Caption or Dialog item, using video stills 
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5. Add and position the graphic for the first Caption item  

6. Click the Next Buildable arrow in the WYSIWYG toolbar to display the next Dialog item  

7. If the Graphic for each dialog checkbox is selected in the Writing tab, you should add a graphic 
for the next Dialog item 

8. Repeat these steps until you have added graphics for each piece of Dialog if necessary  

9. Check the Image memory tab once the graphics have been added to the page and ensure that the 
‘Size on Disk’ value is not over 300k, and that the ‘Size in Memory’ value does not exceed 
12288kb  

10. For each piece of dialog on the page, select each in turn from the Trigger Item drop-down list in 
the Assign to tab, and then check that the appropriate graphics are set to show for each Dialog 
item  

11. Graphics associated with individual Dialog items should automatically hide when next Dialog item 
is displayed  

12. Preview the page  
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Try It 

 

Figure 53: A developed Try It page in the Graphics tab 

 

Figure 54: A published Try It page 
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Overview 
Try Its are a guided practice strategy used for demonstrating key steps in a task. Try Its require learners to 
perform specified tasks using a software application. This may require learners to navigate a GUI’s screen 
elements, complete common procedures, or familiarize themselves with the application.  

When previewed in the Player, a Try it consists of a Try It box and a Steps box. The Try it box contains the 
Try It Stem, which defines the task to be completed by learners, a built-in player prompt, and the Show 
Me button. The Steps box lists each of the steps that must be carried out by learners to successfully 
complete the task defined within the Stem. The individual steps of the task are outlined in the order in 
which they must be performed. Allowable interactions in a Try It include clicking or selecting an interface 
element, inputting text into a field, rolling over an object, double-clicking an object or dragging-and-
dropping an object.  

If a learner completes a step correctly, the interface will reflect the action taken and enable the learner to 
continue to the succeeding step. Each step can have a number of Correct actions associated with it. For 
example, in the Try It step “Select File-New”, there are two Correct actions. The first Correct action is to 
select File and second Correct action is to select New. The Visual designer assigns hotspots to both 
elements on the background interface. When the learner selects File, the interface will change to display 
an open File menu. 

If learners prefer to see an animation of the Try It being completed, they can click the Show Me button. 
The Show Me completes all remaining incomplete Try It steps.  

The Instructional Writer provides the screen grabs for all stages (inactive, rollover, activated, result) of a 
step so the Visual Developer can develop the question to allow learners to perform the step, or skip it and 
view the animation. The writer is required to attach grabs for each action via the Graphic references 
feature in Synergy. When all steps have been completed successfully in the simulated application, the 
completion text is displayed. This text reinforces what it is that learners have completed.  

Tasks 
Tasks that you may be required to carry out when developing a Try It page include: 

• Adding a background graphic 

• Cropping and optimizing images 

• Creating highlight images 

• Adding and positioning graphics 

• Creating highlight images 

• Adding Dynamic Pointers 

• Assigning graphics to show or hide with one or more steps or hotspots 

• Setting up Input Fields 

• Setting up Correct Actions 
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• Setting up Drag Options and Drop Targets 

• Positioning the Try It and Steps box on screen 

• Assigning graphic effects 

Steps 
The following is the recommended sequence of steps that you should follow when building a Try It page: 

1. Prepare the graphics for the page 

• Read the content, including any graphic direction 

• Determine which screengrabs are associated with each step 

• Determine how the screengrabs will be used – screengrabs can be used to create static graphics 
that appear onscreen following a learner interaction such as a rollover or click, or to create 
highlight images, which function as buttons 

• Crop and optimize screengrabs 

• Create highlight images for buttons or menu options 

2. Set up the introduction to the page 

• Add and position any graphics for the introductory stem 

• Add a dynamic pointer indicating where the learner should click to start the first step (in other 
words, indicate the location of the first click action) 

• In the Assign To tab, all graphics that you add are automatically set to show for Step [1] (except 
the Dynamic Pointer, which is not assigned to anything) 

• Assign the Dynamic Pointer to show with the first hotspot 

3. Set up each step 

The process for setting up a step differs depending on the type of step or the type of interactions in the 
step you are working on. There are two types of steps: standard Steps and Code Steps. Standard Steps 
may contain correct actions, input fields, drag options, or drop targets. Code Steps require the learner to 
type in a blank field within a piece of code. 

3.1 Setting up Correct Actions in standard Steps 

Correct actions are triggered using a click, right-click, double-click, or rollover. Select each step in turn 
from the Trigger Item drop-down list, and add the graphics associated with that step once it has been 
selected 

• Select the Step that you wish to work on from the Step drop-down list in the Select tab 
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• Read the Step text that appears in the Steps box – based on this text, you should be able to 
determine the type of event required to trigger the action for the step (rollover, click, double-
click, right-click) 

• Read the Graphic Direction for the Step 

• The hotspot for the first Correct action for the Step displays in the graphics area when you select 
the Step in the Select tab 

Note: The hotspot is named using the naming convention SX – CX, where S is the 
Step number and C is the Correct Action number. 

• Rollover the Correct Action hotspot to determine the name of the interface element that the 
Correct Action is related to 

Note: When you rollover a hotspot in a Try It, the name of the element with which 
the hotspot is associated appears in the bottom left corner of the Synergy 
interface, in the status bar. 

• Position the Correct Action hotspot over the interface element identified 

• If necessary, create a highlight image for that interface element, so that you can simulate a 
rollover effect for that element when the learner attempts the step 

• If you are including a highlighter image, right-click the Correct Action hotspot and select Hotspot 
to Button 

• Browse to and select the highlighter image and click Open 

• By default, Correct Actions are set up to be triggered by left-clicking them – if a different event 
triggers the action (rollover, right-click, or double-click) you must change the Complete Action 
Event setting to reflect this 

• Right-click the Correct action hotspot and select Complete Action Event – then choose Right-Click, 
Double-Click, or Rollover, as appropriate  

• Lock the hotspot in place 

• Determine what graphic change occurs when the hotspot triggers 

• If a new graphic appears when the hotspot is triggered, add that graphic and position it in the 
graphics area 

• Check the Image memory tab once the graphics have been added to the page and ensure that 
the ‘Size on Disk’ value is not over 200k, and that the ‘Size in Memory’ value does not exceed 
12288kb 

• Assign the graphic to show with the Correct Action hotspot 
Graphics Tab Manual Visual_Design_Graphics_Tab_Manual 
Last saved by: Ray Cunningham Date: 07 August 2014 Page 85 of 177 

 



Note:  

By default all new graphics are assigned to show with Step 1 – this occurs so that the Visual 
Designer can see that the graphic has been added. Unless the graphic is intended to display for 
Step 1, you must unassign it from Step 1 and reassign it to the correct hotspot or Step. To do 
this, select Step 1 from the Trigger Item drop-down list in the Assign To tab. Then clear the 
Show checkbox for the graphic in question.  
Select the Hotspot or Step with which you would like the graphic to appear from the Trigger 
Item drop-down list. Then select the Show checkbox for the graphic. 

• Alternatively, if a graphic disappears when the Correct Action hotspot is triggered, assign that 
graphic to Hide with the hotspot 

• Save your changes 

• Preview the step 

 

3.2 Setting up Drag-and-Drop actions in standard Steps 

Drag and drop hotspots are connected and require the learner to drag an object from the Drag hotspot to 
the Drop hotspot. If a writer creates a step with a Drag-and-Drop action, this results in two hotspots being 
added to the Graphics tab - DO and DT, where DO is the draggable option, and DT is the draggable target.  

To set up drag-and-drop actions, you complete these steps: 

• Select the Step that you wish to work on from the Step drop-down list in the Select tab 

• Read the Step text that appears in the Steps box, and identify the draggable object (for example, 
an icon) 

• Create a draggable highlighter image for this draggable object 

Note: Standard highlighter images contain these four states in order: Normal, 
Mouseover, Click, and Deactive. 
Draggable highlighter images are different, however, because most objects that 
are draggable do not have a rollover state. Instead, they only react when clicked. 
Therefore, when setting up the draggable highlighter image, you must replace the 
Mouseover state with a copy of the Normal state. In other words, the four states of 
the draggable highlighter image should be: Normal, Normal, Click, and Deactive.  

• Change the DO hotspot to a button using the draggable highlighter image 

• Position the DT hotspot over the area to which the learner must drag the object 
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Note: Synergy allows you to convert DT to a button if there is a rollover effect on 
DT. However, you are not required to convert a DT hotspot to a button, and in most 
cases it is unnecessary, and even incorrect to do so.  
However, you are required to convert the DO hotspot to a button. 

3.3 Setting up Input fields in Standard Steps 

Input fields require the learner to type text in a text entry field. If a step contains an input field, a blank 
text field is generated in the graphics area, allowing the learner to enter text. Each Input field is 
associated with either a Correct Action (input) or a Submit button, which the learner must click before 
the Player will judge the text entered.  

Note: It is not possible to trigger the Player to judge an input field by pressing a 
keyboard key, such as the Enter key. The Correct Action (input) or the Submit 
button must be used instead. 

To set up an Input field, you complete these steps: 

• Select the Step that you wish to work on from the Step drop-down list in the Select tab 

• Read the Step text that appears in the Steps box and identify the field in which the text must be 
typed, and also how judging is triggered (by clicking an interface element or the Submit button) 

• Position the input field so that it covers the area of the interface (screengrab) into which the 
learner must type – you can resize the input field if necessary 

Note: In most cases, the writer provides a result grab, showing what the interface 
should look like when the learner has finished typing the text. Ideally, you should 
line up the input field so that the text being typed lines up with that shown in the 
result grab. 

• In the screengrab, ensure that the area of the interface into which the learner must type is 
blanked out until AFTER the step is completed 

• If the writer has associated a Correct Action (input) with the input field, a hotspot named SX-CU 
(where SX is the Step number, and CU stands for Correct User Input) is available in the Graphics 
area 

• Set up the Correct Action (input) in the same way that you would set up a standard correct action, 
assigning graphics to Show or Hide with it as necessary 

• If the writer has specified that the Submit button is to be used to trigger the Player to judge Input 
fields, a Submit button is shown in the Steps box, and the Assign To tab lists Hotspot Button [SX-
SUB] in the Trigger Item drop-down list (where S is the Step number, and SUB indicated the 
Submit button) 
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• Assign graphics to Show or Hide with this Hotspot Button, just as you would with a standard 
Hotspot button 

3.4 Setting up Code Steps 

A Code Step is similar to a standard step with an Input field. The difference is that blank field in a Code 
Step occurs within a piece of code generated by the Code Editor. 

To set up the Code Step, you follow these steps: 

• Select the Step that you wish to work on from the Step drop-down list in the Select tab 

• Read the Step text that appears in the Steps box and identify how judging is triggered (by clicking 
an interface element or the Submit button) 

• Position the code where appropriate onscreen 

Note: You should ensure that the code is positioned in such a way that it is not 
obscured by the Try It or Steps boxes. 

• If there is code associated with more than one step, you must determine how the pieces of code 
relate to each other 

Note: The Try It template doesn’t facilitate building code. Therefore, in most cases, 
if a Try It contains multiple pieces of code, the code pieces will either be identical, 
or just be slight variations of the same piece of code – for example, the Code for 
Step 1 might have “MISSING CODE” written in part of it, and then the Code for Step 
2 might have a blank text field where the “MISSING CODE” occurred.  

• If the pieces of code are the same (allowing for slight variations to facilitate the MISSING CODE 
tag), then you must ensure that you position them with pixel perfect precision from one step to 
the next so that no jumps occur – this means ensuring that the X,Y coordinates for each piece of 
code are identical 

• Resize the code area if necessary 
If resizing the code area, you must ensure that you do not introduce line wrapping by mistake. 
The code should maintain the line wrapping set by the writer in the Code Editor. 

• If the writer has associated a Correct Action (input) with the input field, a hotspot named SX-CU 
(where SX is the Step number, and CU stands for Correct User Input) is available in the Graphics 
area 

• Set up the Correct Action (input) in the same way that you would set up a standard correct action, 
assigning graphics to Show or Hide with it if necessary 

• If the writer has specified that the Submit button is to be used to trigger the Player to judge Input 
fields, a Submit button is shown in the Steps box, and the Assign To tab lists Hotspot Button [SX-
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SUB] in the Trigger Item drop-down list (where S is the Step number, and SUB indicated the 
Submit button) 

• Assign graphics to Show or Hide with this Hotspot Button, just as you would with a standard 
Hotspot button 

Note: In many Code Steps, there no graphic change occurs when the learner clicks 
the Correct Action (input) hotspot or the Submit button. Clicking the hotspot or 
button simply triggers the Player to judge the code entry. In those cases, it is fine 
not to assign any graphics to the hotspot or button. 

• Save your changes 

• Preview the step 

Troubleshooting: If you preview the final step in the Try It and discover that the 
code disappears when the Submit button is clicked (or when the Correct Action 
(input) hotspot is clicked, the Try It is not set up correctly in the Code Editor. If the 
code is to be shown onscreen when the Completion Text displays, the Writer must 
select the Show with Feedback checkbox for the code in the Code Editor. You 
should contact the writer to fix this error. 

 

4. Finalize the page 

• Add a dynamic pointer to indicate the starting point for the Try It 
The dynamic pointer must point to the first correct action that the learner should interact with. It 
must be assigned to Show for the first hotspot. It does not need to be set to hide – it does this 
automatically. 

• Position the Try It and Step box 
The Try It box must always be positioned above the Steps box. In exceptional cases, if it is 
impossible to position the Try It box above the Steps box due to space constraints, you may 
position the Try It box on the left of the screen, and the Steps box on the right. However, this is 
not ideal and should be avoided if possible. 

• Lock all elements into place 

• Save your changes 

• Preview the page 
When previewing the page, it is important that you complete the Try It and trigger the 
Completion text, so that you can view the screen space taken up by the Completion text and 
ensure that it fits onscreen. 
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Tasks specific to the Try It template 

Cropping and optimizing screengrabs 
When preparing screengrabs for use in Try It, you must adhere to SkillSoft guidelines exactly. When 
cropping and optimizing screengrabs, you must complete these steps: 

• Open all of the screengrabs for the page in Photoshop 

• Crop each screengrab to a size of 796 by 432 

• Copy and paste each cropped screengrab into an individual layer in a single Photoshop document 

• Name the layers in a sequence 

• Identify the base screengrab 

• Identify the graphic differences between each screengrab and the preceding screengrab 

• Remove all other areas from the subsequent screengrabs, leaving only the graphic differences 

• Save each layer as a separate PNG-8 file using the naming convention <SynergyPage ID><position 
in sequence>_<original screengrab number>  

Note: These steps assume that you are using Adobe Photoshop. If you are using a 
different graphics package, you will need to adjust the steps to suit. 

 

Creating Highlight images 
Often menu items, buttons, or other interface elements become highlighted when a user moves the 
cursor over them. For example, when users move their cursor over the Bold button on the mini-toolbar in 
Word 2007, the button highlights with a bright yellow color to indicate that this interface component is 
about to be selected. A highlight image contains four states of a particular interface component.  

• The Normal state 
How the interface component looks when it has not been rolled over (or moused over) by the 
user 

• The Mouse Over state 
The Mouse Over state is how the interface component looks when users move their mouse over 
it 

• The Click state 
How the interface component looks when users click it 

• The Deactivate state 
The Deactivate state is the “grayed-out” version of the button, which is displayed when the 
button cannot be selected 
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When creating a highlight image, place all four states side-by-side in the same document in your image 
editing program.  

Note: Synergy requires all four states to be present for the image to be a valid 
highlight image. Even if there is no Deactive state– copy the Normal state of the 
interface component and use this as a place holder for the Deactive state. 

To get the graphics for the four states, you must use the screengrabs that have been provided for the 
interaction in that page. 

• Open the layer containing the highlight for the highlighted image 

• Select the layer by pressing Ctrl and clicking the layer containing the highlight in the layers palette 

• Hide the layer containing the highlight by clearing the Visibility box in the Layers palette. This 
displays the marquee, at the exact size of the highlight section 

• Copy the section within the marquee from the first layer. This will form the Normal state for your 
Highlight image. 

• Select File-New to create a new document for your Highlight image. The New dialog box opens. 
The Width and Height specified in this dialog box represents the exact width and height of the 
marquee area. 

Note: Each state of the interface component you are creating must be exactly the 
same pixel height and width. 

• Select Edit-Paste to paste the image that you copied from the marquee area in Layer001 into the 
new document. This is copied to the center of the document and represents the Normal state 

• Move the image to the far left-hand side of the Highlight Image document. Now you need to get 
the Mouse Over state for the interface component. 

• Return to the Photoshop document containing all the screengrabs for that page and turn on 
visibility for the second layer, which should contain the Mouse Over image 

• Return to the Highlight Image document and select Edit – Paste. This pastes the Mouse Over 
state into the center of the Highlight Image document. 

• Again return to the Photoshop document containing all the screengrabs, and turn on visibility and 
select the third layer which contains the Click state 

• Select Edit-Copy to copy it 

• Return to the Highlight Image document and paste the Click state into it. 

• Move the graphic to align in with the Mouse Over state. It should appear third from the left. 
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• Return to the Photoshop document to get Deactive state. However, in most cases there is no 
Deactive state. 

• Once you have determined that there is no Deactive state, return to the Highlight Image 
document. 

• Synergy requires four states to be provided to ensure that the Highlight image is valid and works 
properly. Copy the Normal state and place it as a placeholder for the Deactive state. 

• Drag the copy of the Normal state to the far right of the Highlight Image document 

Note: You must be pixel perfect in placing this image. 

• Save the Highlight Image document as a PNG-8 file with appropriate optimization settings and 
import it into Synergy by converting a hotspot to a button 

• Once the Highlight image is added to the graphics area, lock the image in place using the Locking 
Graphic methodology in Section 4.  

Creating Draggable Highlight Images 
To create a Draggable Highlight image, follow the steps for creating a standard highlight image. However, 
instead of including a Mouseover state, include a second Normal state instead. 

Adding dynamic pointers 
To add a dynamic pointer 

• Right-click the area of the graphic that a learner is to click and select Add Highlighter-Dynamic 
Pointer 

• Select the type of pointer you require - Left, Right, Up, or Down 

• Set the dynamic pointer to show with the appropriate hotspot 

 

Converting a hotspot to a button 
To render an interface item in a graphic interactive;  

• Right-click the hotspot and select Hotspot To Button 

• Browse to locate the relevant special highlight image. The hotspot changes to the highlight image 
which you must position correctly over the appropriate interface item in the graphic 

Note: Once done, check the Trigger item drop-down menu, to ensure that the 
Hotspot name has been updated to Hotspot Button [SX-CX]. It was previously 
named Hotspot [SX-CX] 
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• Use the Hide checkbox in the Select tab to ensure that you have positioned the hotspot button 
graphic correctly. Estimate where the hotspot button graphic should be placed to prevent pixel 
jumps. 

• Clear the Hide checkbox to display the hotspot button graphic again in the Graphics area and 
using the arrow keys carefully nudge the Hotspot button graphic in the correct direction.  

• Once done, select the Hide checkbox again, and observe carefully, watching for any pixel jumps 

• Once you are satisfied that there are no pixel jumps, clear the Hide checkbox and Lock the 
graphic in place by using the Locking graphics methodology in Section 4 

 

Assigning a graphic to appear when a hotspot is triggered 

Note:  

When you open a Try It page in the Graphics area for the first time, the only hotspot visible is 
the hotspot associated with the first Correct action in Step[1]. To view remaining hotspots, 
hold the Shift key and click the hotspot. If there is a subsequent Correct action associated with 
Step[1], its hotspot will appear onscreen. If not, the hotspot associated with the first Correct 
Action in the next Step in the Try It appears. 

To assign a graphic to appear when a hotspot is triggered: 

• Convert the hotspot to a button, if necessary 

• Select the hotspot or hotspot-button from the Trigger Item drop-down list and select the Show 
checkbox associated with the graphic that you want to appear when that hotspot is clicked (or 
double-clicked, right-clicked, or rolled over, depending on what the Complete Action Event is set 
to) 

• Click Toggle Preview Mode to determine that the step is functioning correctly 

To set a graphic to disappear when a hotspot is triggered, simply select the Hide checkbox instead of the 
Show checkbox in the Assign To tab. 

Positioning the Try It and Steps box 
The Try It and Steps boxes must be positioned in such a way that there is room for them to expand (to 
include the Show Me button, or the Completion text in the Try It box, or to include additional steps in the 
Steps box), without obscuring any important pieces of the screengrabs in the background. 

The Try It box must always be positioned above the Steps box. In exceptional circumstances, where this is 
not possible, you may position the Try It box to the left of the screen, and the Steps box to the right of the 
screen; however, you should try to avoid this situation. 
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To position the Try It and the Steps boxes: 

• Right-click the Try It or Steps box and select Unlock Panel 

• Drag the box to its new location 

• Right-click and select Lock Panel to lock the Try It box or Steps box in place 
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Rate Single 

 

Figure 55: A developed Rate Single page in the Graphics tab 

 

Figure 56: A published Rate Single page 
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Overview 
A Rate Single page aims to examine an opinion or a behavior by posing a question and asking learners to 
rate their opinion, behavior, and so on from a scale of options. A Rate Single differs from standard 
question types because it isn’t used in Practice and Test modes and there are no correct or incorrect 
options. A Rate Single page consists of a Text item, which holds the question stem, and a minimum of 
three options. A maximum of five options is permitted. 

Tasks 
Tasks that you may be required to carry out when developing a Rate Single page include: 

• Adding a background graphic 

• Adding a single graphic 

Steps 
The following is the recommended sequence of steps that you should follow when building a Rate Single 
page: 

1. Read the content, including any graphic direction provided 

2. Add a background graphic if necessary 

3. Add and position a single graphic for the question stem 

4. Check the Image memory tab once the graphic has been added to the page and ensure that the 
‘Size on Disk’ value is not over 100k, and that the ‘Size in Memory’ value does not exceed 
12288kb 

5. Lock the graphic in place 

6. Preview the page 

Note:  

The Rate template only allows you to add a single graphic to the page, and that graphic is 
static. You cannot apply any effects to the graphic, nor can you add a staged animation. The 
maximum size of the graphic that you can add is 478x322. 
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Reflect Learner 

 

Figure 57: A Reflect Learner page in the Graphics tab 

 

Figure 58: A published Reflect Learner page 
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Overview 
The Reflect Learner template provides learners with an opportunity to pause and reflect on a question, 
problem, or situation and then enter and record their thoughts. The Player stores the comments for recall 
later. A Reflect Learner template consists of a Text item, which holds the question stem, a Reflective text 
prompt, which indicates the steps for answering the question, and the Unique learner-entered response 
ID, which is used to identify the appropriate Reflect Learner template to recall later in the course. The 
Unique learner-entered response ID field is visible only in the Writing tab.  

Tasks 
Tasks that you may be required to carry out when developing a Reflect Learner page include: 

• Adding a background graphic 

• Adding a (single) graphic 

Steps 
The following is the recommended sequence of steps that you should follow when building a Reflect 
Learner page: 

1. Read the content, including any graphic direction 

2. Add a background graphic if necessary 

3. Add and position a single graphic for the Text item 

4. Check the Image memory tab once the graphic has been added to the page and ensure that the 
‘Size on Disk’ value is not over 100k, and that the ‘Size in Memory’ value does not exceed 
12288kb 

5. Lock the graphic in place  

6. Preview the page 

Note:  

The Reflect Learner template only allows you to add a single graphic to the page, and that 
graphic is static. You cannot apply any effects to the graphic, nor can you add a staged 
animation. The maximum size of the graphic that you can add is 360x355. 
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Reflect Expert Compare 

 

Figure 59: A Reflect Expert Compare in the Graphics tab 

 

Figure 60: A published Reflect Expert Compare page 
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Overview 
The Reflect Expert Compare template is used to record learners’ thoughts about a question or statement 
and immediately compare their answers to an expert’s opinion or best practice. The Reflect Expert 
Compare template consists of a Text item, which holds the question stem, a reflective text prompt, which 
indicates the first step to record the learner’s opinion, an Expert opinion text header, which outlines the 
second step to display the Expert opinion, and Expert opinion text, which holds the expert opinion.  

Tasks 
Tasks that you may be required to carry out when developing a Reflect Expert Compare page include: 

• Adding a background graphic 

• Adding a graphic 

 

Steps 
The following is the recommended sequence of steps that you should follow when building a Reflect 
Expert Compare page: 

1. Read the content, including any graphic direction 

2. Add a background graphic if one has not already been applied 

3. Add and position a graphic for the Text Item 

4. Check the Image memory tab once the graphic has been added to the page and ensure that the 
‘Size on Disk’ value is not over 100k, and that the ‘Size in Memory’ value does not exceed 
12288kb 

5. Lock the graphic in place  

6. Preview the page 

Note:  

The Reflect Expert Compare template only allows you to add a single graphic to the page, and 
that graphic is static. You cannot apply any effects to the graphic, nor can you add a staged 
animation. The maximum size of the graphic that you can add is 360x182. 
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Reflect Self Compare 

 

Figure 61: A developed Reflect Self Compare page 

 

 

Figure 62: A published Reflect Self Compare page 
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Overview 
The Reflect Self Compare template is used to record learners’ thoughts about a question or statement 
and immediately compare them to a recalled reflection. The recalled reflection was recorded using a 
Reflect Learner template. The Reflect Self Compare template contains a single Text item, a Learner 
entered text header, a Learner recalled text header, and a Previous Learner-entered response ID drop-
down list. The Text item holds the question stem that learners reflect upon. The Learner entered text 
header provides the heading for the text field where learners type their reflections. The Learner recalled 
text header provides the heading for the field in which the previous recorded learner entry is to be 
displayed. This information is identified by using the ID supplied by the Instructional Writing in the 
Previous Learner-entered response ID drop-down list in the Writing tab.   

Tasks 
Tasks that you may be required to carry out when developing a Reflect Self Compare page include: 

• Adding a background graphic 

• Adding a graphic 

Steps 
The following is the recommended sequence of steps that you should follow when building a Reflect Self 
Compare page: 

1. Read the content, including any graphic direction 

2. Add a background graphic if necessary 

3. Add and position a single graphic for the Text item 

4. Check the Image memory tab once the graphic has been added to the page and ensure that the 
‘Size on Disk’ value is not over 100k, and that the ‘Size in Memory’ value does not exceed 
12288kb 

5. Lock the graphic in place  

6. Preview the page 

Note:  

The Reflect Self Compare template only allows you to add a single graphic to the page, and that 
graphic is static. You cannot apply any effects to the graphic, nor can you add a staged 
animation. The maximum size of the graphic that you can add is 360x182. 
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Click-In Graphic 

 

Figure 63: A developed Click-In Graphic page 

 

Figure 64: A published Click-In Graphic page 

Graphics Tab Manual Visual_Design_Graphics_Tab_Manual 
Last saved by: Ray Cunningham Date: 07 August 2014 Page 103 of 177 

 



Overview 
A Click-in Graphic question asks the learner to select appropriate area(s) or object(s) in a graphic. These 
areas are defined by hotspots on the graphic. At least one or more of the hotspots will represent the 
desired correct response, and one or more of the hotspots will represent incorrect responses. Learners 
select the hotspots on the graphic and immediately get feedback on their answers. 

Note: The size of the Graphics area in the Click-in graphic template is 440 x 432 
pixels. 

Tasks 
Tasks that you may be required to carry out when developing a Click-in graphic question include: 

• Adding a background graphic 

• Adding and positioning a Click-in graphic 

• Adding and positioning standard graphics 

• Adding and positioning a Final graphic 

• Positioning hotspots and labels 

• Adding highlighters or pointers 

• Assigning graphics to show with the stem or one or more hotspots/labels 

• Assigning graphic effects 

Steps 
The following is the recommended sequence of steps that you should follow when building a Click-in 
Graphic page: 

1. Read the content, including any graphic direction provided 

2. Add a background graphic if one has not already been applied 

3. Add and position a single Click-in Graphic 

Note:  

The Click-in Graphic template only allows you to add a single Click-in Graphic to the page. This is 
a special type of static graphic. You cannot apply any effects to the graphic, nor can you add a 
staged animation. The maximum size of the graphic that you can add is 440x432. 
Often the Click-in Graphic is the only graphic on this page. You position the Correct and 
Incorrect Hotspots over specific areas in this graphic. When the learner clicks those hotspots, it 
triggers choice-specific feedback. However, because this graphic is a Click-in Graphic, any 
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location in the graphic that is not a Correct Hotspot is automatically an Incorrect Hotspot, and 
all clicks are counted as attempts.  

4. Position the hotspots over the appropriate graphic sections of the click-in graphic, and if labels 
are published, position them as appropriate 

5. Add and position standard graphics if required 

Note:  

When you add a standard graphic to the page, you must assign that graphic to show with the 
Stem or with one of the correct or incorrect action hotspot/labels. If you assign it to show with 
the Stem, it will display for the entire page. Whereas if you assign it to show with a correct or 
incorrect hotspot/label, it will only be displayed if the learner clicks that hotspot/label. 

6. Check the Image memory tab once the graphics have been added to the page and ensure that 
the ‘Size on Disk’ value is not over 100k, and that the ‘Size in Memory’ value does not exceed 
12288kb 

7. To view the associated material for each correct or incorrect action hotspot/label on the page, 
press and hold the Shift key and then click each hotspot/label in turn 

8. If a result or final graphic is required, add a Final graphic to the page 

Note:  

The Click-in Graphic template only allows you to add a single Final Graphic to the page. This is a 
special type of static graphic. You cannot apply any effects to the graphic, nor can you add a 
staged animation. The maximum size of the graphic that you can add is 440x432. 
This graphic is automatically set to appear when the learner completes the question. By default, 
the z-depth of this graphic is set to the front of the page, so if you add a Final graphic that is the 
same size and in the same position as the Click-in graphic, it can appear to the learner as though 
this graphic replaces the Click-in graphic when it is displayed. 

9. Lock all elements into place 

10. Preview the page 

Tasks specific to the Click-in graphic template 

Adding a Click-in Graphic 
To add the “Click-in Graphic” graphic to the page: 

• Right-click and select Add - Click-in Graphic  

This graphic is automatically assigned to the Stem of the question. 
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Adding a Final Graphic 
To add the “Final Graphic” graphic to the page: 

• Right-click and select Add - Final Graphic  

This graphic is automatically assigned to the Stem of the question. 

Viewing a Final Graphic 
When you add the Final Graphic, it is automatically set up in the page to display when the learner 
completes the question in the Player. To preview it, you can use the Previewer, or click the Toggle 
Preview Mode button and complete the question. If you need to work with this graphic in the Graphics 
area (to reposition it for example), you must progress advance the Graphics tab to the result stage of the 
page. To do this, you complete these steps: 

1. Press Shift and click a correct or incorrect hotspot/label 

2. Repeat until the Final Graphic appears in Graphics area 

3. Reposition the Final Graphic as required 

4. Lock the Final Graphic in place 

5. Click the Reset Page button in the WYSIWYG toolbar to reset the page to the start state 

6. Preview the page 

7. Save your changes 
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Multiple Choice Wide 

 

Figure 65: A developed Multiple Choice Wide page 

 

Figure 66: A published Multiple Choice Wide page 
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Overview 
A Multiple Choice Wide question template presents the learner with a question stem (presenting a 
question or problem) and a list of options in text format, which consist of correct and incorrect answer 
choices. The learner is expected to select the correct answers from those on the list. 

Tasks 
In the Multiple Choice Wide question template, the question box stretches across the screen. In the 
practice version of this template (which occurs within a learning point or the main topic content), the 
page contains a background graphic.  

However, the test version (which is added to an objective in a topic) of the Multiple Choice Wide 
template does not support a background graphic. 

When developing a Multiple Choice Wide page, you should first determine whether the page is a practice 
or test version of the page.  

Note: Test versions are all stored within the objectives. Practice versions occur 
within the main topic area. 

Then if the page is a practice page, you should check to ensure a background graphic has been added. If 
not, you should add a background graphic to the page. 
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Multiple Choice Standard 

 

Figure 67: A developed Multiple Choice Standard page 

 

Figure 68: A published Multiple Choice Standard page 
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Overview 
A Multiple Choice Standard question template presents the learner with a question stem (presenting a 
question or problem) and a list of options in text format, which consist of correct and incorrect answer 
choices. The learner is expected to select the correct answers from those on the list. This page also 
supports a graphic and a background graphic. 

Note: If the page is in standard mode, the available graphics area is 440x432. If the 
page is set to Draggable, the graphics area is 796x432. 

Tasks 
Tasks that you may be required to carry out when developing a Multiple Choice Standard question 
include:  

• Adding a background graphic 

• Adding and positioning graphics 

• Adding show or hide effects to graphics 

• Adding and positioning highlighters and pointers 

• Positioning code 

• Changing the z-depth of graphics 

• Assigning graphic effects 

• Locking graphics 

Steps 
The following is the recommended sequence of steps that you should follow when building a Multiple 
Choice Standard page: 

1. Read the content, including any graphic direction 

2. Add a background graphic if one has not already been applied 

3. Add and position any graphics for the question stem 

4. Check the Image memory tab once the graphics have been added to the page and ensure that 
the ‘Size on Disk’ value is not over 100k, and that the ‘Size in Memory’ value does not exceed 
12288kb 

5. Position any code 

6. Lock all graphics in place  

7. Preview the page 
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If the page includes code or syntax, you must also position the code or the Syntax box for the Stem.  

If transition effects are required, you must apply them to the graphics.  
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Multiple Choice Graphic Options 

 

Figure 69: A developed Multiple Choice Graphic Options page 

 

Figure 70: A published Multiple Choice Graphic Options page 
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Overview 
A Multiple Choice Graphic Options question template presents the learner with a question stem and a set 
of graphic options, which represent correct and incorrect answer choices. The learner is expected to 
select the correct answers. In this template, the question options are provided in the form of small 
graphics. 

Note: The Graphic options are set to 105x105 pixels.  

Tasks 
Tasks that you may be required to carry out when developing a Multiple Choice Graphic Options question 
include:  

• Adding a background graphic 

• Adding Answer Option graphics (105 by 105 pixel) 

Steps 
The following is the recommended sequence of steps that you should follow when building a Multiple 
Choice Graphic Options page: 

1. Read the content, including any graphic direction 

2. If necessary, add a background graphic 

Note:  

If the Multiple Choice Graphic Options page has been added as a test question, background 
graphics are not supported. Practice questions do support background graphics. 

3. Add answer option graphics – these graphics can be a maximum size of 105x105 pixels 

4. Check the Image memory tab once the graphics have been added to the page and ensure that 
the ‘Size on Disk’ value is not over 100k, and that the ‘Size in Memory’ value does not exceed 
12288kb 

5. Preview the page ensuring the correct graphics are associated with the choice-specific 
feedbacks 
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Multiple Choice Fill-in Code 

 

Figure 71: A developed Multiple Choice Fill-in Code page 

 

Figure 72: A published Multiple Choice Fill-in Code page 
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Overview 
A Multiple Choice Fill-in Code question template presents the learner with a question stem (presenting a 
question or problem) and a list of options in text format, which consist of correct and incorrect coding 
answers. The Graphics area displays a piece of code containing a blank field. The learner is expected to 
select the correct piece of code to complete the blank field from those on the list. This page also supports 
a graphic and a background graphic. 

Note: If the page is in standard mode, the available graphics area is 440x432. If the 
page is set to Draggable, the graphics area is 796x432. 

Tasks 
Tasks that you may be required to carry out when developing a Multiple Choice Fill-in Code question 
include:  

• Adding a background graphic 

• Positioning code 

• Adding and positioning graphics 

• Adding show or hide effects to graphics 

• Adding and positioning highlighters and pointers 

• Changing the z-depth of graphics 

• Assigning graphic effects 

• Locking graphics 

Steps 
The following is the recommended sequence of steps that you should follow when building a Multiple 
Choice Fill-in Code page: 

1. Read the content, including any graphic direction 

2. Add a background graphic if necessary 

3. Position the code and the question box 

4. Add and position any graphics for the question stem 

5. Check the Image memory tab once the graphics have been added to the page and ensure that 
the ‘Size on Disk’ value is not over 100k, and that the ‘Size in Memory’ value does not exceed 
12288kb 

6. Lock all graphics in place  

7. Preview the page 
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If the page includes syntax, you must also position the Syntax box for the Stem.  

If transition effects are required, you must apply them to the graphics.  
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Matching Standard Text 

 

Figure 73: A developed Matching Standard Text page 

 

Figure 74: A published Matching Standard Text page 
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Overview 
A Matching Standard Text question template presents the learner with a list of options in one column and 
a list of associated targets in another column. Options and targets in this template can be words, 
sentences, or phrases. The learner is required to match the options with the appropriate targets by 
dragging the letter associated with an option to a placeholder in the target area.  

 

Tasks 
In the Matching Standard Text question template, the question box stretches across the screen. In the 
practice version of this template (which occurs within a learning point or the main topic content), the 
page contains a background graphic.  

However, the test version of the Matching Standard Text template does not support a background 
graphic. 

When developing a Matching Standard Text page, you should first determine whether the page is a 
practice or test version of the page.  

Note: Test versions are all stored within the objectives. Practice versions occur 
within the main topic area. 

Then if the page is a practice page, you should check to ensure a background graphic has been added. If 
not, you should add a background graphic to the page. 
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Matching Standard Graphic 

 

Figure 75: A developed Matching Standard Graphic page 

 

Figure 76: A published Matching Standard Graphic page 
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Overview 
A Matching Standard Graphic question template presents the learner with a question stem, accompanied 
by a list of text options and a set of associated graphic targets. The learner is required to match the text 
options with the appropriate graphic targets.  

 

Tasks 
Tasks that you may be required to carry out when developing a Multiple Choice Graphic Options question 
include:  

• Adding a background graphic 

• Adding answer option graphics (90 by 90 pixels) 

Steps 
The following is the recommended sequence of steps that you should follow when building a Matching 
Standard Graphic Options page: 

 

1. Read the content, including any graphic direction 

2. If necessary, add a background graphic 

3. Add target graphics – these graphics can be a maximum size of 90x90 pixels 

4. Check the Image memory tab once the graphics have been added to the page and ensure that 
the ‘Size on Disk’ value is not over 100k, and that the ‘Size in Memory’ value does not exceed 
12288kb 

5. Preview the page ensuring the text options are linked to the appropriate target graphics 
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Rank/Sequence 

 

Figure 77: A developed Rank/Sequence page 

 

Figure 78: A published Rank/Sequence page 
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Overview 
A Rank/Sequence question template presents the learner with question stem, a list of options, and 
associated numbered targets. Ranking/Sequencing questions require the learner to assign some kind of 
an order or priority to content.  

Tasks 
In the Rank/Sequence question template, the question box stretches across the screen. In the practice 
version of this template (which occurs within a learning point or the main topic content), the page 
contains a background graphic.  

However, the test version of the Rank/Sequence template does not support a background graphic. 

When developing a Rank/Sequence page, you should first determine whether the page is a practice or 
test version of the page.  

Note: Test versions are all stored within the objectives. Practice versions occur 
within the main topic area. 

Then if the page is a practice page, you should check to ensure a background graphic has been added. If 
not, you should add a background graphic to the page. 
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Short Answer Text 

 

Figure 79: A developed Short Answer Text page in the Graphics tab 

 

 

Figure 80: A published Short Answer Text page 
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Overview 
A Short Answer Text question template requires the learner to respond to a question by entering an 
answer into an input field in the Question box on screen. Graphics may be added to a Short Answer Text 
page to provide additional information that may be needed to answer the question. The graphic may be a 
photograph, chart, data sheet, formulas, or conceptual image.  

Tasks 
Tasks that you may be required to carry out when developing a Short Answer Text question include: 

• Adding a background graphic 

• Adding and positioning graphics 

• Adding and positioning highlighters and pointers 

• Changing the z depth of graphics 

• Assigning graphic effects 

• Locking graphics 

• Positioning code 

Steps 
The following is the recommended sequence of steps that you should follow when building a Short 
Answer Text page: 

1. Read the content, including any graphic direction provided 

2. If necessary, add a background graphic if one has not already been applied 

3. Add and position any additional graphics 

4. Check the Image memory tab once the graphics have been added to the page and ensure that 
the ‘Size on Disk’ value is not over 100k, and that the ‘Size in Memory’ value does not exceed 
12288kb 

5. Add any required effects to graphics 

6. Lock all graphics in place 

7. Preview the page 

If the page includes code or syntax, you must also position the code or the Syntax box for the Stem.  

If transition effects are required, you must apply them to the graphics.  
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Short Answer Graphic 

 

Figure 81: A developed Short Answer Graphic page 

 

Figure 82: A published Short Answer Graphic page 
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Overview 
Short Answer Graphic questions require the learner to respond to a question by entering an answer into 
an input field within the graphics area. In the Writing tab, the Writer uses the Code Editor to provide any 
onscreen text or code for the page, and also to indicate the correct answer, which the learner is required 
to type. In the Graphics tab, an input field corresponds to the correct answer specified in the Code Editor. 
The designer must position that field onscreen. 

Note: 

As of July 2014, a known bug in the RIA affects the display of code in this template. Until a 
player fix is available, an interim workaround must be applied to ensure the code is displayed 
correctly. The steps to complete this workaround are available below: Workaround for Code 
Display Bug in RIA Player 

Tasks 
Tasks that you may be required to carry out when developing a Short Answer Graphic question include: 

• Adding a background graphic 

• Adding and positioning graphics 

• Positioning text/code and the answer input field onscreen 

• Adding and positioning highlighters and pointers 

• Changing the z depth of graphics 

• Assigning graphic effects 

• Locking graphics 

Steps 
The following is the recommended sequence of steps that you should follow when building a Short 
Answer Graphic page: 

1. Read the content, including any graphic direction provided 

2. If necessary, add a background graphic if necessary 

3. Drag and position that the code box containing the answer input field, resizing the box if 
necessary, so that it fits in the graphics area on the page 

4. Add and position any additional graphics 

5. Check the Image memory tab once the graphics have been added to the page and ensure that 
the ‘Size on Disk’ value is not over 100k, and that the ‘Size in Memory’ value does not exceed 
12288kb 
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6. Add any required effects to graphics 

7. Lock all graphics in place 

8. Preview the page  

Workaround for Code Display Bug in RIA Player 
Due to a known bug in the RIA player, code is not being displayed properly in Short Answer Graphic 
questions. This is because the location of the code element has not been properly defined by the 
software, so it is sometimes obscured by the question box.  

To prevent this problem from occurring you must force Synergy to define the location of the code by 
completing the workaround described below.  

Here is a Short Answer Graphic question as created. The code and the question box are both in their 
default positions. This question will display properly in SCP, but the Tablet player can’t handle it. You 
must make two changes to the question.   

 

Figure 38: Default treatment of code in Short Answer Graphic template 

 

1. Select the code element and adjust the width so it matches the code instead of running all the 
way across the screen 
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Figure 39: Step 1 of the workaround 

2. Move the code element slightly on the page (up or down, left or right – it doesn’t matter) and 
save the page 

 

Figure 40: Step 2 of the workaround 

This will define the location of the code element in the course xml. The RIA player will then know where 
to position it on the page. These steps should be followed for all Short Answer Graphic questions in 
production.  
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SkillCheck 

 

Figure 83: A developed SkillCheck page in the Graphics tab 

 

Figure 84: A published SkillCheck page 
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Overview 
The SkillCheck is the question template that corresponds to a Try It. There are two main differences 
between a SkillCheck and a Try It. The first is the presentation of the Steps box. In a Try It, the steps 
appear in the Steps box before the learner attempts each step. In the SkillCheck, the steps do no appear 
in the Steps box until the learner has completed them successfully or attempted them unsuccessfully and 
played the Show Me animation. The second difference is the provision of choice-specific feedback and 
specific incorrect options. In the Try It, the learner is guided through the completion of the step or steps, 
whereas in the SkillCheck, the learner is putting what they have learned into practice. For this reason, as 
well as setting up correct actions or hotspots onscreen, incorrect actions or hotspots are also provided in 
the SkillCheck page. If the learner clicks one of these incorrect hotspots by mistake, choice-specific 
feedback is provided to provide them with a hint about how to correctly complete the step. 

Tasks 
Tasks that you may be required to carry out when developing a SkillCheck page include: 

• Cropping and optimizing images 

• Creating highlight images 

• Adding a background graphic 

• Adding and positioning graphics 

• Assigning graphics to show or hide with one or more steps 

• Setting up input fields 

• Setting up Correct Actions 

• Setting up Incorrect Actions 

• Setting up Drag Options and Drop Targets 

• Positioning the SkillCheck and Steps box on screen 

• Assigning graphic effects 

• Positioning code 

Steps 
To complete most Tasks in SkillChecks, you follow the steps for completing those same tasks in Try Its. 
(see Try Its) 

The only extra steps that you must carry out in a SkillCheck are to set up the incorrect actions. The 
incorrect actions are named using this naming convention: SX – CX – IX, where S is the step number, C is 
the correct action number, and I is the incorrect action number. Each correct action may have up to two 
associated incorrect actions. 

To set up each incorrect action: 
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1. Rollover the incorrect action hotspot to determine the name of the interface element that the 
incorrect action is related to 

Note:  

When you rollover a hotspot in a SkillCheck, the name of the element with which that 
hotspot is associated appears in the bottom left corner of the Synergy interface, in the status 
bar. 

2. Position the hotspot over the interface element identified 

3. If necessary, create a highlight image for that interface element, so that you can simulate a 
rollover effect for that element when the learner attempts the step 

4. If you are including a highlighter image, right-click the incorrect action hotspot, and select 
Hotspot to Button 

5. Browse to and select the highlighter image and click Open 

6. Lock the hotspot/button in place 

7. Save your changes  

8. Preview the page 
When previewing the page, it is important that you complete the Try It and trigger the 
Completion text, so that you can view the screen space taken up by the Completion text and 
ensure that it fits onscreen. 
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Drag and Drop Activity 
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Overview  
Drag and Drop Activities are engaging, game-like activities used for reinforcing the key learning elements 
in a course. The template used to create the activity is very flexible, allowing you to add a base graphic 
and place the question box, options, and targets anywhere on the page. It supports timed questions, 
immediate feedback to answers, and an animated final graphic. There are a lot of tasks involved in 
creating the activity, but equally there is a great deal of freedom to create unique and memorable 
activities.  

There are three stages to the activity: 

• The first stage presents the question stem and invites the learner to complete the activity. 

• In the feedback stage the learner receives overall feedback, can find specific feedback on each 
choice, and has a choice between retaking the activity or moving on to the final feedback. 

• In the final stage of the activity the learner sees text and a graphic that summarise the activity. 
The graphic may be animated, and could show the correct matches, or the real world result of 
getting the matches correct. For example, if the activity involves placing the parts of a machine 
correctly, the final graphic could show an animation of the operating machine. 

The writer provides graphic direction for the overall activity and for each option. They may also provide 
graphic direction for the targets, depending on the activity. They will specify how the options and targets 
are matched and the general behaviour of the question. They will also provide graphic direction for the 
final activity stage.  

Tasks  
Tasks that you may be required to carry out when developing a Drag and Drop Activity include: 

• Adding a base graphic 

• Adding and positioning option graphics 

• Positioning target hotspots 

• Adding a final graphic 

• Adding a final animation 

Steps  
The following is the recommended sequence of steps that you should follow when building aDrag and 
Drop Activity:  

1. Prepare and add the graphics for the Activity phase  

a. Read the content, including all graphic directions. 

b. Develop a base graphic for the page, including target areas . 

c. Develop option graphics. All option graphics must be the same size. 
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d. Define the layout of the text box - Standard or Wide. 
Note: In a future build, the designer will be able to define the exact width and height of 
the text box instead of choosing between these two options. 

e. Position all graphics on the page. 

f. Position the target hotspots. 

g. Position the timer, if necessary. 

2. Prepare and add the graphics for the Final Answer phase 

a. Read the final answer graphic directions. 

b. Develop the graphic to add to the page. 

c. Develop the animation, if required. 

 

There are no design steps specific to the Drag and Drop Activity template. The distinguishing feature of 
this template is that so little of the page is templatized, you have almost complete control over the 
appearance of the page. But the only tasks to carry out are adding and positioning graphics and hotspots 
(and possibly creating an animation for the final stage).  

Text Box layout 
There are two text box layouts to choose from: 

 

The standard layout is 390 pixels wide 

 

The Wide layout is 770 pixels wide.  

The default is the Standard layout, but you can switch layouts using the dropdown at the top of the page. 
In both cases, the height of the text box will depend on the amount of text; the box will grow to 
accommodate all text.  
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Timer 

 

If the writer selects the Timed mode for the activity, a timer graphic will be created automatically. The 
timer can’t be deleted, but you can position it anywhere on the page.  

Tooltips 
The writer may add tooltips to the options or target areas. These tooltips are positioned automatically by 
the software, they can’t be edited. If the tooltips are causing a problem in the layout you may have to 
return to the writer and ask them to make the tooltips shorter.  

Activity and Final Answer phases 

 

There are two phases in the Drag and Drop Activity to be designed. The Activity phase is the question 
phase, which includes the draggable options and target areas. The Final Answer phase is shown after the 
activity has been completed and feedback given. The Final Answer graphic may simply show the correct 
answers to the activity, or it may show a different graphic, something that represents the result of 
completing the activity correctly. The Final Answer graphic is independent of the earlier graphics, so can 
be completely different if you wish.  

To switch between the Activity and Final Answer phases, you use the radio buttons at the bottom of the 
graphics area.  

Defining the Option and Target Sizes 
All of the option graphics in a particular activity must be the same size, but the size may differ from 
activity to activity. When you add the first option graphic, it sets the option size for the activity. All other 
options must be that size.   

The default is for each target to hold a single option. The target area is therefore the same size as an 
option. If the writer has selected the Reusable targets checkbox on the Writing tab, the target area will 
be the same size as several options. The default setting is for each target area to be large enough to hold 
as many options as have been assigned to any of the targets. For example, if there are five options and 
targets in a question, and each option is matched to one target, the default size of the target areas is the 
same size as an option. If two options are matched to a target, all targets will be large enough to hold two 
options.  

This default behavior can be overridden using the Target Size dropdown. The minimum target size is 
determined by the number of options matched to any target in the activity, but the target can be set to 
hold up to 14 options. This is the equivalent of creating foil targets. There may only be two correct 
matches to a target, but by making the target area larger you are making the learner work that out.   

You can also control the shape of the target areas.  

For example, suppose the target size is set to three. The target area could look like  
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a)  

 

b)  

 
 

c)  

 

 

 

You control the shape of the target area by going to the Target Layout Option dropdown menu and 
selecting the number of columns.  

 

If you select one column, the three targets must be stacked on top of each other like this.  

 

If you select two columns, an ‘extra’ target space is created so the target area is symmetrical.  

 

If you select three columns, the three targets are placed side by side.  

The maximum number of columns you can select in the Target Layout Option dropdown is the same as 
the value in the Target Size dropdown. You can’t select a four-column layout when the targets are only 
large enough to hold three options.  
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Question Set 

 

Figure 85: A developed Question Set page in the Graphics tab 

 

Figure 86: A published Question Set page 
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Overview 
The Question Set template presents a “set” of practice or test questions on related content. It consists of 
a base page and two to five question pages. The base page contains an introduction, a prompt, and 
Question buttons. The introduction to the Question Set outlines the goal of the question set. It makes it 
clear to learners what task or objective they are practicing, or being tested on. The prompt instructs the 
learner on how to perform the Question set and the remainder of the Question Set comprises a series of 
questions that learners can answer. Allowable child pages in a Question Set include: 

• Multiple Choice Wide 

• Multiple Choice Standard 

• Multiple Choice Fill-in Code 

• Multiple Choice Graphic Options 

• Click-in Graphic 

• Matching Standard Text 

• Matching Graphic 

• Rank/Sequence 

• SkillCheck 

• Short Answer Graphic/Text 

Learners click each Question button to navigate to and take a question.  

Tasks 
Tasks that you may be required to carry out when developing a Question Set include: 

• Adding a background graphic to the base page 

• Adding a graphic to the base page 

• Building the graphical look and feel of each of the question types enclosed within the Question 
Set 

Steps 
The following is the recommended sequence of steps that you should follow when building a Question 
Set: 

1. For each page within the Question Set, read the content, including any graphic direction 
provided 

2. Add a background graphic to each page within the Question Set if one has not already been 
applied 
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3. Add and position any graphics for the Question Set stem in the base page 

4. Check the Image memory tab once the graphics have been added to the page and ensure that 
the ‘Size on Disk’ value is not over 100k, and that the ‘Size in Memory’ value does not exceed 
12288kb 

5. Lock the graphics in place 

6. Preview the page 

7. Design each of the child question pages in the Question Set 

8. Lock all elements in place on each page 

9. Preview each page 
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Case Study Templates 

Overview 
A Case Study presents learners with an opportunity to apply their knowledge of the subject matter at 
hand in a real-life situation. Case Study scenarios can be actual or contrived. A Case Study includes a base 
page and two to five child questions. The case study scenario is presented on the base page. Learners 
answer questions based on the scenario in each of the child pages. Child pages may include any of the 
following question templates:  

• Multiple Choice Wide 

• Multiple Choice Standard 

• Multiple Choice Fill-in Code 

• Multiple Choice Graphic Options 

• Click-in Graphic 

• Matching Standard Text 

• Matching Standard Graphic 

• Rank/Sequence 

• SkillCheck 

• Short Answer Text 

• Short Answer Graphic 

The learner may return to the base page at any time during a question. Synergy stores answers already 
provided to the question until the learner returns. In Synergy, there are five Case Study template types: 

• Case Study Standard 

• Case Study Explore Graphic 

• Case Study Explore List 

• Case Study Sim Dia 

• Case Study Sim Dia Video Caption 

• Case Study Serial Multi Choice 

The difference between the first four templates is the manner in which the scenario on the base page is 
presented. In the Case Study Standard template, the scenario is presented as a single Text item with an 
associated graphic. In a Case Study Explore Graphic, the scenario is presented as an Explore Graphic. In 
the Case Study Explore List, the scenario is presented as an Explore List. In the Case Study Sim Dia, the 
scenario is presented as Sim Dialog.  
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Case Study Serial Multi Choice pages are quite different from other case study templates. They consist of 
a Case Study base page and a series of scenario/situation-related vignette questions in a specific order. 
These pages are known as Serial branches and are specific to the Case Study Serial Multi Choice template. 
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Case Study Standard 

 

Figure 87: A developed Case Study Standard page 

 

Figure 88: A published Case Study Standard page 
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Overview 
In the Case Study Standard template, the scenario within the base page is presented as a Text item with 
an associated graphic. The Text item on this page can be set to a Standard width or a Wide width. If the 
case study scenario is long and cannot fit into the Text item provided, a learning aid containing the 
scenario details can be provided in a Launch box.  

Tasks 
When developing a Case Study Standard, you need to develop the base page as well as the two to five 
child pages. Tasks in developing the base page may include: 

• Adding a background graphic 

• Adding and positioning graphics 

• Assigning graphics to Show/Hide with the Text item 

• Assigning graphic effects 

• Locking graphics 

For a list of tasks that are specific to each child question page, refer to the relevant Question template in 
this manual. 

Steps 
The following is the recommended sequence of steps that you should follow when building a Case Study 
Standard:  

1. Begin with the base page and read its content and graphic direction 

2. If necessary, add a background graphic 

3. Add and position any graphics for the scenario 

4. Check the Image memory tab once the graphics have been added to the page and ensure that 
the ‘Size on Disk’ value is not over 100k, and that the ‘Size in Memory’ value does not exceed 
12288kb 

5. Lock all graphics in place 

6. Preview the base page 

7. Build each child page 

Note: For each child page, refer to the relevant Question template in this manual 
for instructions on how to build it.  

8. Check the Image Memory tab for each child page 

9. Lock all graphics in place and on completion preview each child page 
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10. When all pages have been built, preview the Case Study in its entirety 
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Case Study Explore Graphic 

 

Figure 89: A developed Case Study Explore Graphic page 

 

Figure 90: A published Case Study Explore Graphic page 
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Overview 
In the Case Study Explore Graphic template, the scenario within the base page is presented as an Explore 
Graphic. 

Tasks 
When developing a Case Study Explore Graphic you need to develop the base page as well as two to five 
child pages. The base page is built in much the same way as a standard Explore Graphic page. For tasks 
relating to each child page, refer to the relevant Question template in this manual. 

Steps 
The following is the recommended sequence of steps that you should follow when building a Case Study 
Explore Graphic page: 

1. Begin with the base page and read its content and graphic direction 

2. If necessary, add a background graphic 

3. Add and position any graphics for the scenario 

Note: Consult the Explore Graphic template instructions to determine how to set up 
and build the base page. 

4. Check the Image memory tab once the graphics have been added to the page and ensure that 
the ‘Size on Disk’ value is not over 100k, and that the ‘Size in Memory’ value does not exceed 
12288kb 

5. Lock all graphics in place 

6. Preview the base page 

7. Build each child page 

Note: For each child page, refer to the relevant Question template in this manual 
for instructions on how to build it.  

8. Check the Image memory tab for each child page 

9. Lock all graphics in place and on completion preview each child page 

10. When all pages have been built, preview the Case Study in its entirety 
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Case Study Explore List 

 

Figure 91: A developed Case Study Explore List page 

 

Figure 92: A published Case Study Explore List page 
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Overview 
In the Case Study Explore List Template, the scenario within the base page is presented in the form of an 
Explore List. The explore list contains one Text item and a number of List items and associated material.  

Tasks 
When developing a Case Study Explore List, you will need to develop the base page as well as between 
two and five child pages. The base page is built in much the same way as a standard Explore List page. For 
tasks relating to each child page, refer to the relevant Question template type in this manual. 

Steps 
The following is the recommended sequence of steps that you should follow when building a Case Study 
Explore List: 

1. Begin with the base page and read its content and graphic direction 

2. If necessary, add a background graphic 

3. Add and position any graphics for the scenario 

Note: Consult the Explore List template instructions to determine how to set up 
and build the base page. 

4. Check the Image memory tab once the graphics have been added to the page and ensure that 
the ‘Size on Disk’ value is not over 100k, and that the ‘Size in Memory’ value does not exceed 
12288kb 

5. Lock all graphics in place 

6. Preview the base page 

7. Build each child page 

Note: For each child page, refer to the relevant Question template in this manual 
for instructions on how to build it.  

8. Check the Image memory tab for each child page 

9. Lock all graphics in place and on completion preview each child page 

10. When all pages have been built, preview the Case Study in its entirety 
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Case Study Sim Dia 

 

Figure 93: A developed Case Study Sim Dia page 

 

Figure 94: A published Case Study Sim Dia page 

Graphics Tab Manual Visual_Design_Graphics_Tab_Manual 
Last saved by: Ray Cunningham Date: 07 August 2014 Page 149 of 177 

 



Overview 
In the Case Study Sim Dia Template, the scenario within the base page is presented as dialog. 

Tasks 
When developing a Case Study Sim Dia, you need to develop the base page as well as between two and 
five child pages. You build the base page in the same way you would build a standard Sim Dia template. 
For tasks relating to each child page, refer to the relevant Question template type in this manual. 

Steps 
The following is the recommended sequence of steps that you should follow when building a Case Study 
Sim Dia page: 

1. Begin with the base page and read its content and graphic direction 

2. If necessary, add a background graphic 

3. Add and position any graphics for the scenario 

Note: Consult the Sim Dialog template instructions to determine how to set up 
and build the base page. 

4. Check the Image memory tab once the graphics have been added to the page and ensure that 
the ‘Size on Disk’ value is not over 100k, and that the ‘Size in Memory’ value does not exceed 
12288kb 

5. Lock all graphics in place 

6. Preview the base page 

7. Build each child page 

Note: For each child page, refer to the relevant Question template in this manual 
for instructions on how to build it.  

8. Check the Image memory tab for each child page 

9. Lock all graphics in place and on completion preview each child page 

10. When all pages have been built, preview the Case Study in its entirety 
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Case Study Sim Dia Video Caption 

 

Figure 95: A developed Case Study Sim Dia Video Caption page 

 

Figure 96: A published Case Study Sim Dia Video Caption page 

Overview 
In the Case Study Sim Dia Video Caption template, the scenario within the base page is presented as 
dialog. 

Tasks 
When developing a Case Study Sim Dia Video Caption, you need to develop the base page as well as 
between two and five child pages. You build the base page in the same way you would build a standard 
Sim Dia Video Caption template. 
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Case Study Serial Multi Choice 

 

Figure 97: A developed Case Study Serial Multi Choice page 

 

Figure 98: A published Case Study Serial Multi Choice page 
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Overview 
The Case Study Serial Multi Choice template is very similar in function to a Single Path RolePlay, but it is 
used for “non-role play” decision making scenarios where the learner may not actually be interacting with 
another character. The Case Study Serial Multi Choice template consists of a base page and a series of 
scenario/situation-related vignette questions in a specific order. There are four main components to a 
Case Study Serial Multi Choice base page: 

• Introduction, which outlines an actual or contrived scenario  
This must fit into a single Text item but if it cannot, a learning aid can be provided containing the 
details of the scenario 

• a relevant graphic 

• a prompt, which provides clear instructions to the learner  
This prompt is canned and is provided by the Course Player. It directs the learner to choose a 
button – the Explore button or Score button.  

• buttons that direct the learner to choose a mode (Explore or Score) to begin the Case Study 
The Explore button enables to proceed through the Case Study in an exploratory fashion. 
Learners can make any or all selections within an active vignette and do not advance to the next 
vignette until they choose to. 
In Score mode, learners get one try to select an answer to a vignette question, and after receiving 
feedback, click Continue to move to the next question in the series. 

Each Case Study Serial Multi Choice branch page contains five main components: 

• a stem  
This is limited to one Text item. 

• a relevant opening graphic 

• options 

• feedback for each option that consists of: 

a. Response Audio Text for each option 

b. The Response Audio Text for each option displays at the same time as the Feedback Text 
and graphic for that option and provides audio reinforcement relevant to the visual effect 
of the choice made 

c. Response graphic for each option  

d. The Response graphic for each option displays at the same time as the Response Audio 
Text and Feedback Text for that option, and it illustrates the impact of the option on the 
graphic associated with the stem 

e. Response Feedback Text for each option, which is different from the Response Audio Text 
for each option  
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f. Response Feedback Text for each option tells learners how the choice they made is rated 
and provides a rationale for the rating 

• The Player automatically ends a Case Study Serial Multi Choice with a Summary page or a 
Threshold page, depending on how well the learner did in the case study. The Summary page is 
generated by the Player. In Explore mode, the Summary page simply outlines the content 
attributes that the learner explored. In Score mode, the Summary page outlines how the learner 
faired on each content attribute within the Case Study. It gives a summary of the number of good, 
fair and poor choices made by the learner. 

• The Threshold page is displayed if the learner fails to achieve the threshold score to “pass” the 
case study. When this occurs, the learner is immediately brought to a Threshold page for 
feedback, instead of being allowed to continue through the Case Study. 

Note:  

The maximum size of a graphic in the Case Study Serial Multi Choice base page is 375 x 350 
pixels. The maximum size of a graphic in a Serial Branch page is 375 x 237 pixels. 

 

Tasks 
When developing a Case Study Serial Multi Choice template, you need to develop the base page as well as 
a series of scenario/situation-related vignette child questions. Tasks in developing the base page may 
include: 

• Adding a background graphic to the page or the graphics area 

• Adding graphics 

• Setting up graphic effects 

Tasks in developing each child page (Serial Branch page) may include: 

• Adding a background graphic to the page or the graphics area 

• Adding graphics 

• Setting up graphic effects 

Steps 
The following is the recommended sequence of steps that you should follow when building a Case Study 
Serial Multi Choice: 

• For each page within the Case Study Serial Multi Choice, read the content, including any graphic 
direction provided 

• If necessary, add a background graphic to the Case Study Multi Choice 
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• With the Summary Mode radio button selected, add and position any graphics that you want to 
appear with the introduction to the Case Study, and to reappear when the Case Study Summary 
page is displayed 

• Check the Image memory tab once the graphics have been added to the page and ensure that 
the ‘Size on Disk’ value is not over 100k, and that the ‘Size in Memory’ value does not exceed 
12288kb 

• Lock the graphics in place 

• Preview the base page 

• Determine whether or not the page requires a Threshold Mode page 

Note:  

In the Writing tab, select Threshold from the Characteristics drop-down menu. If the Threshold 
%: (1-100) field is blank, or set to “0” then the page does not require a Threshold Mode design. 
If any other value is specified in this field, then the page requires a Threshold Mode design. 

• If the page requires a Threshold Mode page, read the Threshold Response Text and Threshold 
Feedback in the Writing tab, as well as any Graphic Direction or Alt text provided by the Writer 

• Return to the Graphics tab and select the Threshold Mode radio button, and add a single graphic, 
which will appear if the learner triggers the Threshold Response 

Note:  

You should only add a single graphic to the Threshold Mode. If you add more than one graphic, 
the latest graphic is the only one that will appear when the Threshold page is displayed. All 
other graphics will be moved to the Summary Mode display. 

• For each Serial Branch page in the Case Study: 

a. Add and position the graphic for the Text Item 

Note:  

The Assign To tab and the Select tab are disabled for this template. To work on a particular 
page element, you first click that element in the graphics area. For example, if you want to add 
the graphics for the first response choice, you click that response choice, and then add the 
graphics. 

b. Click the first response choice and add and position the graphic(s) for that choice 

c. Click the second response choice and add and position the graphic(s) for that choice 
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d. Repeat this step for any remaining response choices 

Note:  

At any point, you can navigate back to the initial Text Item for the page by clicking the Text 
Item area (which is where the Response Audio Text is displayed when you select a Response 
Choice). 

e. Lock all elements in place 

f. Preview each Serial Page 

• Check the Image memory tab for each page in the Case Study 

• When the Case Study is completely built, preview it in its entirety – if the page contains a 
Threshold Mode, you must trigger the Threshold when previewing the page to ensure the 
Threshold Mode displays correctly 
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Roleplay Templates 

Overview 
Roleplays are learning activities that simulate real-life scenarios based on the cause-effect interaction of 
decisions that people make and relationships they have in their workplace environment. In a Roleplay, 
the learner is presented with a cause-and-effect situation. This regularly but not exclusively involves 
another character, or characters, but always presents several options that reflect potential responses the 
learner could make to the situation. Each Response choice has two types of feedback associated with it: 
Response Audio feedback from the character in the RolePlay, and instructional feedback about the choice 
itself (whether it is a good, fair, or poor choice). The learner advances through the Roleplay on a path 
determined by the responses chosen. 

Each response choice is tied to a particular attribute (characteristic) related to the topic of instruction in 
which the Roleplay is located. Choices are rated good, fair, or poor in regard to the attribute. As learners 
progress through the Roleplay, their selections are assessed and at the end of the Roleplay, attribute-
specific feedback is provided. 

When used for practice, the learner can choose to complete the Roleplay in either Explore or Score mode. 

• In Explore mode, the learner is allowed to explore all feedback for all Response Choices in an 
individual Roleplay scene and navigate back and forth between the scenes using the Player 
navigation buttons. 

• In Score mode, learners are required to make a decision based on what they believe is the best 
response in the situation presented. Learners do not have the freedom to examine the Response 
Choice before being scored. Each learner Response Choice is rated against the Roleplay’s set of 
attributes. 

A Roleplay begins with the presentation of a scenario on a lead-in page, followed by child pages that 
represent the individual scenes that pose questions or stimuli to which learners must respond. At the end 
of the Roleplay, a player generated summary page is presented to the learner which summarizes his or 
her performance in the Roleplay.  

The lead-in page to a Roleplay consists of a Text item, which provides an overview of the scenario or 
situation the learner will be entering. This Text item has an associated graphic. Depending on whether the 
learner is taking the Roleplay in practice mode, the page also contains an Explore and a Score button. 

Each child page presents the learners with an opening stimulus or question, an associated graphic, and 
several response choices that represent possible responses to the question or stimulus posed in the 
scene. The learner chooses a response from those provided and gets three types of feedback specific to 
the selected response. 

The three types of feedback are: 

• Graphic feedback 
This represents the visual aspect of the character’s reaction to the selection the learner makes.  
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• Response Audio text 
This represents what the character has to say in reaction to the response selected by the learner 

• Response Feedback text 
This tells the learner how well he/she performed in this scene, according to what was taught in 
the preceding instruction 

• There are two types of Roleplays available in SkillSoft courses: 

a. Single Path Roleplays 

b. Multi Path Roleplays 

• Both types of Roleplays are similar but differ in the manner in which the learner progresses 
through the Roleplay and in the logic used to develop them. 

 

Video support 

Both RolePlay templates may support video. If video is enabled, certain additional tasks are required.  

Integrating Video 
The source for the video for the RolePlay pages is generally provided in MP4 format. This video must be 
edited in accordance with the Video Development guidelines, and published in a format suitable for 
integration into Synergy. 

To integrate video in a RolePlay template, you must complete these steps: 

1. Identify the appropriate filename for the video file. The video filename field in the Writing Tab 
supplies the correct video filename, in the format topicnumber_vid_filenumber.  
A Video filename field will appear on the Single Path RolePlay root page, and each RolePlay 
branch page, and for every response option in the branch pages. The Scene, Attire and Props 
graphic direction fields are only added to the RolePlay parent page. 

a. Parent page of the Multi-Path Roleplay 
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Figure 41: The Multi-Path RolePlay parent page does not contain video, and therefore does not contain a video filename. 

b. Root page of the Single Path Roleplay 
Select Threshold from the Characteristics drop-down menu on the Single Path RolePlay 
parent page. The Threshold page content is displayed, and the video file name appears in 
the Filename field in the Video section. This is the filename for the video associated with 
the Threshold Response Text. This video will only appear when the learner attempts the 
RolePlay in Score mode, and chooses inappropriate responses for the questions. 

 

Figure 42: The Single Path RolePlay parent page allows you to access the Threshold page, where you will find a video filename. 

c.  Branch page with video content 
The 1st highlighted area in the Figure below shows the video file name for the stem 
question, and the 2nd shows the video file name for the feedback of the selected option.  
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Figure 43: All branch pages may contain video. There is a video filename associated with the introductory text item, and with 
each piece of Response Audio Text. 

2. Identify the appropriate video format(s).  
If there are multiple video formats in the course, each file will have the same filename, but 
different file types. For example, the filename could be t6_vid_0178. If the course uses the flv 
format, the file would be saved as t6_vid_0178.flv. If the course also uses the mp4 format, 
the mp4 file would be saved as t6_vid_0178.mp4. 

Note: The video formats that are supported in a given course are indicated on the 
Video tabbed page at course level.  

3. Publish the video files to the appropriate format(s) and rename them as per the name given in 
the Video Filename fields in the Writing Tab. 

4. Using Windows Explorer, add the video files to a course by copying them to the media\video 
folder at the topic level of that course folder structure.  
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Figure 44: Video folder in the Synergy course structure 

5. Save the course. 

6. Preview the RolePlay pages to ensure the video has been integrated correctly. 

Integrating static images 
When a page is video-enabled, a static version of the page complete with static images must also be built, 
in case learners view the page with video disabled.  The static images must be stills taken from the video 
file. One image should be added for the introductory text field, and one for each response. The static 
images should be the same size as the video file. Refer to the Video Development guidelines for detailed 
guidelines on the requirements for creating these images.  

For detailed instructions on building the static version of a Single Path RolePlay, refer to Steps in the 
Single Path RolePlay section. 

For detailed instructions on building the static version of a Multi-Path RolePlay, refer to Steps in the 
Multi-Path RolePlay section. 

Note: Whether or not video is enabled in the page, only one graphic may be added 
to each Text Item or Response. 

Integrating audio files 
The audio for the static version of the page must be exported from the source video file for the page. A 
separate audio file is required for each piece of dialog on the page. 

The audio files must be named to match the filenames associated with each piece of dialog in Synergy. 
They should then be converted to SPX format and integrated into the course by adding them to the 
media\audio folder at the topic level of the course structure.
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Single Path Roleplay 

 

Figure 99: A developed Single Path Roleplay in the Graphics tab 

 

Figure 100: A published Single Path Roleplay 
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Overview 
In Single Path Roleplays, the instructional path through the Roleplay is the same for all learners, 
regardless of the choice they make. Learners proceed in a single path from the first scene to the last. 
However, it is possible for learners to be exited early from the Roleplay. If learners select poor responses 
to a number of individual scenes, they can be exited from the Roleplay with feedback stating that they 
should familiarize themselves with the underlying attributes on which the Roleplay is based before re-
attempting it. Single Path Roleplays contain a threshold score, which is determined by the writer. Once 
learners possess a score smaller than the threshold score, they are exited from the Roleplay and brought 
to a Threshold page instead of a Summary page.  

Also, in each child page in a Single Path Roleplay, learners may select a Response Choice that is deemed 
to be “catastrophic” that is, shows they have not understood the attribute under discussion. If a learner 
chooses a catastrophic option he or she is immediately exited from the Roleplay. These exiting features 
are only available in Score mode in Single Path Roleplays. 

Note:  

The maximum size of a graphic in the Single Path Roleplay base page is 375 x 350 pixels. The 
maximum size of a graphic in a Single Path Roleplay Branch page is 375 x 237 pixels. 

Tasks 
When developing a Single Path Roleplay, you need to develop the base page as well as a series of branch 
pages. Tasks in developing the Single Path Roleplay (base) page may include: 

• Adding a background graphic 

• Adding graphics 

• Setting graphic effects 

Tasks in developing each Single Path Roleplay Branch page may include: 

• Adding a background graphic 

• Adding graphics to the Text Item 

• Adding graphics to each of the response choices 

• Assigning graphic effects 

• Adding video for the introductory text item 

• Adding video for each piece of Response Audio text 

Steps 
The following is the recommended sequence of steps that you should follow when building a Single Path 
Roleplay: 
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• For each page within the Single Path Roleplay, read the content, including any graphic direction 
provided 

• If necessary, add a background graphic to the Single Path Roleplay 

• With the Summary Mode radio button selected, add and position any graphics that you want to 
appear with the introduction to the Single Path Roleplay, and to reappear when the Roleplay 
Summary page is displayed 

• Check the Image memory tab once the graphics have been added to the page and ensure that 
the ‘Size on Disk’ value is not over 100k, and that the ‘Size in Memory’ value does not exceed 
12288kb 

• Lock the graphics in place 

• Preview the base page 

• Determine whether or not the page requires a Threshold Mode page 

Note:  

In the Writing tab, select Threshold from the Characteristics drop-down menu. If the Threshold 
%: (1-100) field is blank, or set to “0” then the page does not require a Threshold Mode design. 
If any other value is specified in this field, then the page requires a Threshold Mode design. 

• If the page requires a Threshold Mode page, read the Threshold Response Text and Threshold 
Feedback in the Writing tab, as well as any Graphic Direction or Alt text provided by the Writer 

• Return to the Graphics tab and select the Threshold Mode radio button, and add a single graphic, 
which will appear if the learner triggers the Threshold Response 

Note:  

You should only add a single graphic to the Threshold Mode. If you add more than one graphic, 
the latest graphic is the only one that will appear when the Threshold page is displayed. All 
other graphics will be moved to the Summary Mode display. 

WARNING:  

The available Graphics Area in the Graphics Tab for the Threshold page is larger than the actual 
area available in the Player. The actual area available is 375x237. When you add a graphic to 
the Threshold page, you must keep this in mind. Also, when you add a graphic, please note that 
Synergy centers it by default. To ensure it displays correctly in the Player, you must align it to 
the top of the available graphics area. 

• For each Single Path Roleplay Branch page: 
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c. Add and position the graphic for the Text Item 

Note:  

The Assign To tab and the Select tab are disabled for this template. To work on a particular 
page element, you first click that element in the graphics area. For example, if you want to add 
the graphics for the first response choice, you click that response choice, and then add the 
graphics. 

d. Click the first response choice and add and position the graphic(s) for that choice 

e. Click the second response choice and add and position the graphic(s) for that choice 

f. Repeat this step for any remaining response choices 

Note:  

At any point, you can navigate back to the initial Text Item for the page by clicking the Text 
Item area (which is where the Response Audio Text is displayed when you select a Response 
Choice). 

g. Lock all elements in place 

h. Preview each Single Path Roleplay Branch Page 

• When the Single Path Roleplay is completely built, preview it in its entirety – if the page contains 
a Threshold Mode, you must trigger the Threshold when previewing the page to ensure the 
Threshold Mode displays correctly 
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Multi Path Roleplay 

 

Figure 101: A developed Multi Path Roleplay in the Graphics tab 

 

Figure 102: A published Multi Path Roleplay 
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Overview 
In a Multi Path Roleplay, the choices grow into an inverted tree, with a separate branch for each choice. 
Unlike the Single Path Roleplay, the instructional path can vary, depending on the Response Choices that 
learners make along the way. In other words, the path that the learner may follow in completing the 
Roleplay differs, depending on the choices they make along the way. 

The key features differentiating a Multi Path Roleplay from a Single Path Roleplay are: 

• each Response Choice can lead to a different scene, resulting in multiple branches of instructional 
paths 

• learners jump from one path to another based on choices made 

• learner Response Choices are not re-ordered 

• the template cannot be used for testing 

• multiple attributes can be tested in any one child page 

Note:  

The maximum size of a graphic in the Multi Path Roleplay base page is 375 x 350 pixels. The 
maximum size of a graphic in a Multi Path Roleplay Branch page is 375 x 237 pixels. 

 

Tasks 
When developing a Multi Path Roleplay, you need to develop the base page as well as a series of branch 
pages. Tasks in developing the Multi Path Roleplay (base) page may include: 

• Adding a background graphic 

• Adding graphics 

• Setting graphic effects 

Tasks in developing each branch page may include: 

• Adding a background graphic 

• Adding and positioning graphics for the Text Item 

• Adding and positioning graphics for each of the response choices 

• Setting graphic effects 

Steps 
The following is the recommended sequence of steps that you should follow when building a Multi Path 
Roleplay: 
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1. For each page within the Multi Path Roleplay, read the content, including any graphic direction 
provided 

2. If necessary, add a background graphic to the Multi Path Roleplay 

3. Add and position any graphics that you want to appear with the introduction to the Multi Path 
Roleplay, and to reappear when the Roleplay Summary page is displayed 

4. Check the Image memory tab once the graphics have been added to the page and ensure that 
the ‘Size on Disk’ value is not over 100k, and that the ‘Size in Memory’ value does not exceed 
12288kb 

5. Lock the graphics in place 

6. Preview the base page 

Note: Unlike the Single Path Roleplay, the Multi Path Roleplay does not contain a 
Threshold page. 

7. For each Multi Path Roleplay Branch page: 

a. Add and position the graphic for the Text Item 

Note:  

The Assign To tab and the Select tab are disabled for this template. To work on a particular 
page element, you first click that element in the graphics area. For example, if you want to add 
the graphics for the first response choice, you click that response choice, and then add the 
graphics. 

b. Click the first response choice and add and position the graphic(s) for that choice 

c. Click the second response choice and add and position the graphic(s) for that choice 

d. Repeat this step for any remaining response choices 

Note:  

At any point, you can navigate back to the initial Text Item for the page by clicking the Text 
Item area (which is where the Response Audio Text is displayed when you select a Response 
Choice). 

e. Lock all elements in place 

f. Preview each Multi Path Roleplay Branch Page 

8. When the Multi Path Roleplay is completely built, preview it in its entirety – make sure you 
navigate every path in the Roleplay, previewing every branch page at least once 
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Summary 

 

Figure 103: A developed Summary page in the Graphics tab 

 

Figure 104: A Published Summary page in the Graphics tab 
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Overview 
A Summary page is used in a Summary Learning Point, and is the last page of this topic.  It contains one 
Text item and supports launch boxes and staged animations. The Text Item is set in Wide format.  

Note:  

The Summary Layout 2 template was introduced in Synergy 1.14 as an alternative to the 
Summary template. Eventually the Summary template will be phased out and replaced 
completely by the Summary Layout 2 template. 

Tasks 
Tasks that you may be required to carry out when developing a Summary page include: 

• Adding and positioning graphics 

• Managing the z-depth of graphics 

• Assigning graphic effects 

• Creating basic staged animations 

Steps 
The following is the recommended sequence of steps that you should follow when building a Summary 
page: 

1. Read the content, including any graphic direction provided 

2. Add and position required graphics 

3. Check the Image memory tab once the graphics have been added to the page and ensure that 
the ‘Size on Disk’ value is not over 100k, and that the ‘Size in Memory’ value does not exceed 
12288kb 

4. Add graphic effects if required 

5. Create staged animations if required, and set them to start with the Text Item 

6. Lock all elements into place 

7. Preview the page  

Graphics Tab Manual Visual_Design_Graphics_Tab_Manual 
Last saved by: Ray Cunningham Date: 07 August 2014 Page 170 of 177 

 



Summary Layout 2 

 

Figure 105: A Summary 2 Layout page in the Graphics tab 

 

Figure 106: A Summary 2 Layout page in toggle preview mode 
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Overview 
The Summary Layout 2 template was added in Synergy 1.14 as a replacement for the old Summary 
template. This template has a new look and feel, with a “Summary” header and a border around the text 
box. The graphics area is also smaller at 373 x 407 pixels. Despite the differences in look-and-feel, the 
purpose of the Summary Layout 2 template is identical to that of the Summary template. The 
functionality is also the same. It contains one Text item and supports launch boxes and staged animations. 
The Text Item is set in Wide format.  
 

Note: This new template does not support the addition of a background graphic. 

Tasks 
Tasks that you may be required to carry out when developing a Summary Layout 2 page include: 

• Adding and positioning graphics 

• Managing the z-depth of graphics 

• Assigning graphic effects 

• Creating basic staged animations 

Steps 
The following is the recommended sequence of steps that you should follow when building a Summary 
Layout 2 page: 

1. Read the content, including any graphic direction provided 

2. Add and position required graphics 

3. Check the Image memory tab once the graphics have been added to the page and ensure that 
the ‘Size on Disk’ value is not over 100k, and that the ‘Size in Memory’ value does not exceed 
12288kb 

4. Add graphic effects if required 

5. Create staged animations if required, and set them to start with the Text Item 

6. Lock all elements into place 

7. Preview the page  
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Exercise Overview 

 

Figure 107: A developed Exercise Overview page in the Graphics tab 

 

Figure 108: A published Exercise Overview page 
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Overview 
The Exercise Overview template is the first page in an Exercise Overview Learning Point. This template 
comprises an Exercise Statement which is fixed in position. The Exercise Statement is made up of a single 
Text Item and a task list with a list introduction and up to 6 List items. These are usually set to build. 
Standard graphics cannot be included on this page. The only graphic element the page can contain is a 
background.  

Tasks 
• The only task that you must complete to design the Exercise Overview page is to add a 

background graphic if it doesn’t already contain one. 
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HTML Caption 

 

Figure 109: A published HTML Caption page 

An HTML Caption template is used in Narrated Animation instead of the standard Expos template and it 
allows you to launch Flash animations within the course. HTML Caption templates are not built using the 
Graphics tab. Instead they are developed using Flash. Refer to the HTML Caption handbook for more 
information on developing an HTML Caption page. 
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